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Exploring Microsoft Access 2013, Comprehensive (Poatsy) 

Chapter 1  Introduction to Access: Finding Your Way Through an Access Database 

 

1) Which of the following is a collection of data organized into meaningful information to be 

used in a meaningful way? 

A) Database 

B) Query 

C) Table 

D) Report 

Answer:  A 

Diff: 1 

Objective:  1.  Understand database fundamentals 

 

2) Which of the following best describes information? 

A) Information is a converted into fields and records within a table in a database. 

B) Information is converted into data that can be selected and sorted for business or personal use. 

C) Information is what is entered into a database. 

D) Information is the finished product that is produced by a database. 

Answer:  D 

Diff: 3 

Objective:  1.  Understand database fundamentals 

 

3) An Access database can MOST accurately be described as a structured collection of: 

A) tables. 

B) objects. 

C) records. 

D) modules. 

Answer:  B 

Diff: 3 

Objective:  1.  Understand database fundamentals 

 

4) Which of the following is NOT a main object type in an Access database? 

A) Template 

B) Query 

C) Table 

D) Module 

Answer:  A 

Diff: 3 

Objective:  1.  Understand database fundamentals 
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5) Of the following, which is NOT a main object type in an Access database? 

A) Report 

B) Form 

C) Macro 

D) Record 

Answer:  D 

Diff: 3 

Objective:  1.  Understand database fundamentals 

6) A ________ is a question you ask about data stored in a database. 

A) query 

B) form 

C) report 

D) macro 

Answer:  A 

Diff: 1 

Objective:  1.  Understand database fundamentals 

 

7) Which of the following is an object that adds functionality to a database and is written using 

VBA? 

A) Macro 

B) Module 

C) Query 

D) Report 

Answer:  B 

Diff: 2 

Objective:  1.  Understand database fundamentals 

 

8) Which of the following is NOT a tab in Access 2013? 

A) Create 

B) Home 

C) Format 

D) File 

Answer:  C 

Diff: 2 

Objective:  1.  Understand database fundamentals 

 

9) Which of the following is FALSE about the navigation bar in Access 2013? 

A) It is located at the bottom of the Access window. 

B) It contains buttons to go to a first, previous, next, or last record of a database. 

C) It enables you to find a record based on a single search word. 

D) It is toggled on and off with the F11 key. 

Answer:  D 

Diff: 3 

Objective:  1.  Understand database fundamentals 

 



3 

Copyright © 2014 Pearson Education, Inc. 

10) The ________ view in Access looks similar to an Excel spreadsheet. 

A) Report 

B) Form 

C) Datasheet 

D) Design 

Answer:  C 

Diff: 1 

Objective:  1.  Understand database fundamentals 

11) You can create or modify a table's field names and data types in ________ view. 

A) Report  

B) Form  

C) Datasheet 

D) Design 

Answer:  D 

Diff: 2 

Objective:  1.  Understand database fundamentals 

 

12) A primary key: 

A) must include letters. 

B) must contain a unique value for each record within a table. 

C) has the same value for all records in a relational database. 

D) is a unique record within a relational database. 

Answer:  B 

Diff: 3 

Objective:  1.  Understand database fundamentals 

 

13) Access differs from other Microsoft software because it:  

A) works primarily from memory. 

B) works primarily from storage. 

C) does not save your work as soon as changes are made. 

D) does not allow more than one user to work on a file at a time.  

Answer:  B 

Diff: 3 

Objective:  2.  Use an existing database 

 

14) When you make a change to the content of a record in an Access table, when are the changes 

saved? 

A) When you click the Save or Save As button from the File tab or the button on the Quick 

Access Toolbar 

B) When you press F11 or click the Save button on the Quick Access Toolbar 

C) When you move the insertion point to a different record 

D) When you move the insertion point to a different table, form, query, or report in the database 

Answer:  C 

Diff: 3 

Objective:  2.  Use an existing database 
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15) Which of the following is FALSE about the Undo feature in Access? 

A) You can click Undo to reverse the most recent change to a single record. 

B) You can use Undo to reverse multiple edits in Access. 

C) In Access, the Undo feature works the same as it does in other Office programs. 

D) You can click Undo to redo a change that you made previously. 

Answer:  B 

Diff: 3 

Objective:  2.  Use an existing database 

16) Which of the following is TRUE about Access' Compact and Repair feature? 

A) It fragments a fragmented relational database file. 

B) It defragments a fragmented database file if needed. 

C) It removes objects and stores them in a secondary file. 

D) You should compact your database no more than once a week due to the time required. 

Answer:  B 

Diff: 3 

Objective:  2.  Use an existing database 

 

17) ________ a database rearranges data and objects in a database to make its size smaller. 

A) Backing up 

B) Compressing 

C) Compacting 

D) Fragmenting 

Answer:  C 

Diff: 1 

Objective:  2.  Use an existing database 

 

18) Access' ________ feature creates a duplicate copy of a database. 

A) Back Up Database 

B) RDBMA 

C) Compact and Repair 

D) Relationship 

Answer:  A 

Diff: 1 

Objective:  2.  Use an existing database 

 

19) You can click the ________ button on the table toolbar to sort records in alphabetical order, 

from A to Z. 

A) Sort 

B) Descending 

C) Order 

D) Ascending 

Answer:  D 

Diff: 1 

Objective:  3.  Sort table data on one or multiple fields 

 



5 

Copyright © 2014 Pearson Education, Inc. 

20) When you apply a multiple sort in Access, columns are sorted: 

A) from right to left. 

B) from left to right. 

C) from top to bottom. 

D) by primary field and then by secondary field. 

Answer:  B 

Diff: 2 

Objective:  3.  Sort table data on one or multiple fields 

21) A number, phrase, or expression used to select records in a table is called: 

A) a primary key.  

B) a criterion. 

C) a query. 

D) referential integrity. 

Answer:  B 

Diff: 2 

Objective:  4.  Create, modify, and remove filters 

 

22) Alice is working in a database containing the names, service locations, and services offered 

by landscapers. She needs to find landscapers that offer services in the Phoenix area and that 

service rare plants. The best way for her to search for this data is to perform a: 

A) Filter by Form. 

B) Filter by Selection. 

C) Sort Ascending. 

D) Sort Descending. 

Answer:  A 

Diff: 2 

Objective:  4.  Create, modify, and remove filters 

 

23) Ryan is working in a database that organizes vendor contact information. Ryan must find 

vendors located in Seattle and Portland. The vendors must have offices in both cities in order to 

meet Ryan's requirements. He should use the Filter by Form ________ condition. 

A) query 

B) sort 

C) OR 

D) AND 

Answer:  D 

Diff: 1 

Objective:  4.  Create, modify, and remove filters 
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24) Irene is working in a database that organizes city court case information. Irene must find 

court cases in either Jackson county or Jefferson county. Irene should use the Filter by Form 

________ condition.  

A) query 

B) sort 

C) OR 

D) AND 

Answer:  C 

Diff: 1 

Objective:  4.  Create, modify, and remove filters 

 

25) You may choose Access over Excel in all of the following situations EXCEPT when you: 

A) require multiple related tables to store your data. 

B) need to group data based on various parameters. 

C) need to create complex charts. 

D) have a large amount of data. 

Answer:  C 

Diff: 2 

Objective:  5.  Know when to use Access or Excel to manage data 

26) A relationship is a connection between: 

A) two tables using a field that is common to both. 

B) two or more database files with a common primary field. 

C) two records within the same database. 

D) two or more tables using a common record. 

Answer:  D 

Diff: 3 

Objective:  6.  Understand relational power 

 

27) A relational database has the ability to create relationships between two: 

A) forms. 

B) fields. 

C) files. 

D) tables. 

Answer:  D 

Diff: 3 

Objective:  6.  Understand relational power 

 

28) When you ________, you ensure that data entered into a related table first exists in the 

primary table. 

A) create a foreign key 

B) create a primary key 

C) filter by selection 

D) enforce referential integrity 

Answer:  D 

Diff: 2 

Objective:  6.  Understand relational power 
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29) A field that is defined as a primary key in one table is defined as a(n) ________ in a related 

table. 

A) referential integrity key 

B) relational database 

C) foreign key 

D) primary2 key 

Answer:  C 

Diff: 1 

Objective:  6.  Understand relational power 

 

30) What does a custom Web app enable you to do? 

A) Create databases through Access' Web app. 

B) Create relational tables that can be distributed through the Web. 

C) Create a database and share with others through the Web. 

D) Share and distribute database files without the need for Access to be installed on every 

computer. 

Answer:  C 

Diff: 3 

Objective:  7.  Create a database 

31) Information is what is typically entered into a database. Data is the finished product of the 

database. 

Answer:  FALSE 

Diff: 1 

Objective:  1.  Understand database fundamentals 

 

32) People use databases to store collections of data. 

Answer:  TRUE 

Diff: 1 

Objective:  1.  Understand database fundamentals 

 

33) A complete set of all fields about one person or event is called a field. 

Answer:  FALSE 

Diff: 1 

Objective:  1.  Understand database fundamentals 

 

34) The navigation buttons in Access allow you to step through a table record by record, or to 

quickly go to the first or last record in the table. 

Answer:  TRUE 

Diff: 2 

Objective:  1.  Understand database fundamentals 
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35) The process of saving in Access is nearly the same as it is in other Microsoft Office 

applications. 

Answer:  FALSE 

Diff: 2 

Objective:  2.  Use an existing database 

 

36) The Undo button does not reverse the most recent change in Access 2013. 

Answer:  FALSE 

Diff: 1 

Objective:  2.  Use an existing database 

 

37) Two users cannot work on the same table in a database. 

Answer:  FALSE 

Diff: 2 

Objective:  2.  Use an existing database 

 

38) The F2 key puts you in Edit mode when in Access. 

Answer:  FALSE 

Diff: 1 

Objective:  2.  Use an existing database 

 

39) Backing up a database rearranges the data and objects in a database to decrease its file size, 

thereby making more space available on your disk and letting you open and close the database 

more quickly.  

Answer:  FALSE 

Diff: 2 

Objective:  2.  Use an existing database 

40) Click the File tab to begin the process of compacting and repairing a database. 

Answer:  TRUE 

Diff: 1 

Objective:  2.  Use an existing database 

 

41) A sort can only list records in a database in a specific numeric sequence. 

Answer:  FALSE 

Diff: 1 

Objective:  3.  Sort table data on one or multiple fields 

 

42) Access can sort records by more than one field. 

Answer:  TRUE 

Diff: 1 

Objective:  3.  Sort table data on one or multiple fields 

 

43) Filter by Form uses the AND and OR logical operators. 

Answer:  TRUE 

Diff: 1 

Objective:  4.  Create, modify, and remove filters 
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44) A comparison operator in Access is used to evaluate the relationship between two primary 

keys. 

Answer:  FALSE 

Diff: 2 

Objective:  4.  Create, modify, and remove filters 

 

45) A filter and a sort always produce the same results in an Access database. 

Answer:  FALSE 

Diff: 1 

Objective:  4.  Create, modify, and remove filters 

 

46) Filter by Selection displays only records that match a criterion that you select. 

Answer:  TRUE 

Diff: 2 

Objective:  4.  Create, modify, and remove filters 

 

47) Like Access, Excel can be used to manage large quantities of data. 

Answer:  FALSE 

Diff: 1 

Objective:  5.  Know when to use Access or Excel to manage data 

 

48) Both Access and Excel contain tools that can be used to extract and analyze information. 

Answer:  TRUE 

Diff: 2 

Objective:  5.  Know when to use Access or Excel to manage data 

 

49) Access is preferred over Excel in managing mostly numeric data. 

Answer:  FALSE 

Diff: 2 

Objective:  5.  Know when to use Access or Excel to manage data 

50) Access can create relationships between two tables; Excel cannot. 

Answer:  TRUE 

Diff: 2 

Objective:  6.  Understand relational power 

 

51) Enforce referential integrity is one of only two options available when setting a database 

relationship with another database. 

Answer:  FALSE 

Diff: 2 

Objective:  6.  Understand relational power 

 

52) A template is a predefined database that can be used to jumpstart the creation of a database. 

Answer:  TRUE 

Diff: 1 

Objective:  7.  Create a database 
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53) You can create a Web app from a Web app template from the Backstage view. 

Answer:  TRUE 

Diff: 1 

Objective:  7.  Create a database 

 

54) SharePoint is an add-on program for Access. 

Answer:  FALSE 

Diff: 2 

Objective:  7.  Create a database 

 

55) Custom Web app is available in the Backstage view of Access. 

Answer:  TRUE 

Diff: 2 

Objective:  7.  Create a database 

 

56) A(n) ________ is a collection of organized and meaningful data that can be accessed, 

managed, stored, queried, sorted, and reported. 

Answer:  database 

Diff: 1 

Objective:  1.  Understand database fundamentals 

 

57) A(n) ________ system is a software system that offers tools needed to create, maintain, and 

use a database. 

Answer:  database management 

Diff: 2 

Objective:  1.  Understand database fundamentals 

 

58) Microsoft ________ is the database management system included in Office 20013 

Professional. 

Answer:  Access 

Diff: 1 

Objective:  1.  Understand database fundamentals 

 

59) Tables, queries, reports, and forms are all examples of ________. 

Answer:  objects 

Diff: 1 

Objective:  1.  Understand database fundamentals 

60) Objects that are part of an Access database are available from the ________ within Access. 

Answer:  Navigation Pane 

Diff: 3 

Objective:  1.  Understand database fundamentals 
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61) A(n) ________ is a collection of fields that describe something, such as a person, place, 

event, or idea. 

Answer:  record 

Diff: 2 

Objective:  1.  Understand database fundamentals 

 

62) A(n) ________ is the smallest data element of a table. 

Answer:  field 

Diff: 2 

Objective:  1.  Understand database fundamentals 

 

63) The ________ displays the number of the current record as well as the total number of 

records in a table. 

Answer:  Navigation bar 

Diff: 3 

Objective:  1.  Understand database fundamentals 

 

64) ________ view is a grid containing fields and records. 

Answer:  Datasheet 

Diff: 2 

Objective:  1.  Understand database fundamentals 

 

65) A primary key may use a(n) ________ data type--a generated primary key that is 

automatically incremented each time a record is added. 

Answer:  AutoNumber 

Diff: 3 

Objective:  1.  Understand database fundamentals 

 

66) The ________ utility of Access helps reduce the size of a database. 

Answer:  Compact and Repair 

Diff: 3 

Objective:  2.  Use an existing database 

 

67) The ________ Database utility in Access creates a duplicate copy of a database. 

Answer:  Back Up 

Diff: 3 

Objective:  2.  Use an existing database 

 

68) Access allows you to save a database as a PDF or ________ file, which preserves the object's 

formatting and looks the same on most computers. 

Answer:  XPS 

Diff: 3 

Objective:  2.  Use an existing database 
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69) ________ sorts a list of numeric data from highest to lowest. 

Answer:  Descending 

Diff: 1 

Objective:  3.  Sort table data on one or multiple fields 

 

70) When you are ready to sort a database, click in the field that you want to sort and click the 

________ tab. 

Answer:  Home 

Diff: 1 

Objective:  3.  Sort table data on one or multiple fields 

 

71) Rather than displaying records based on a question as in a query, a(n) ________ hides 

records that do not match a set criteria. 

Answer:  filter 

Diff: 2 

Objective:  4.  Create, modify, and remove filters 

 

72) A(n) ________ is a number, phrase, or expression used to select records from a table. 

Answer:  criterion 

Diff: 3 

Objective:  4.  Create, modify, and remove filters 

 

73) Use ________ if you have mostly numeric data and may require complex charts and graphs. 

Answer:  Excel 

Diff: 1 

Objective:  5.  Know when to use Access or Excel to manage data 

 

74) Use ________ if you have a large amount of data and may need to group, sort, and total the 

data based on various parameters. 

Answer:  Access 

Diff: 1 

Objective:  5.  Know when to use Access or Excel to manage data 

 

75) Access is known as a(n) ________ system because it allows users to administer groups of 

data in tables and create relationships. 

Answer:  relational database management 

Diff: 2 

Objective:  6.  Understand relational power 

 

76) Relationships in a database can be graphically represented by the ________ between the 

tables. 

Answer:  join lines 

Diff: 3 

Objective:  6.  Understand relational power 
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77) Good database design begins with grouping data into correct tables, a practice known as 

________. 

Answer:  normalization 

Diff: 3 

Objective:  6.  Understand relational power 

78) A primary key from one table that is used to form a relationship with a second table is called 

a(n) ________. 

Answer:  foreign key 

Diff: 3 

Objective:  6.  Understand relational power 

 

79) When forming relationships in a relational database, the ________ from one table must be 

joined to the foreign key of another table. 

Answer:  primary key 

Diff: 2 

Objective:  6.  Understand relational power 

 

80) In relational databases, there is a concept known as ________ that ensures that data cannot 

be entered into a related table unless it first exists in a primary table. 

Answer:  referential integrity 

Diff: 3 

Objective:  6.  Understand relational power 

 

81) Match the following terms to their meanings: 

I. query 

II. report 

III. form 

IV. module 

V. macro 

 

A. professional-looking formatted information from tables or queries 

B. object that allows you to enter data and modify data in a database 

C. question you ask about data stored in a database 

D. stored series of commands that carry out an action 

E. object that adds functionality to a database; written using VBA 

Answer:  C, A, B, E, D 

Diff: 2 

Objective:  1.  Understand database fundamentals 
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82) Match the following terms to their meanings: 

I. database 

II. table 

II. record 

IV. field 

V.  object 

 

A. complete set of fields about one person, place, event, or concept 

B. smallest data element of a table 

C. collection of organized data 

D. the main component used to make a database function 

E. an object in which data is stored 

Answer:   C, E, A, B, D 

Diff: 2 

Objective:  1.  Understand database fundamentals 

83) Match the following terms to their meanings: 

I. DBMS 

II. Access 

II. VBA 

IV. RDBMS 

V.  Web app 

 

A. application platform by Microsoft 

B. programming language  

C. software that provides tools needed to create, maintain, and use a database 

D. can easily combine data from multiple tables to create queries, forms, and reports 

E. database management system that is part of Office 2013 

Answer:   C, E, B, D, A 

Diff: 2 

Objective:  Multiple objectives 

 

84) Match the following terms to their meanings: 

I. Access Web app 

II. SharePoint 

II. Office 365 

IV. Access 

V.  XPS file 

 

A. new in Access 2013 

B. Web app platform developed by Microsoft  

C. cloud service edition of SharePoint 

D. preserves an object's formatting 

E. part of Office 2013 

Answer:  A, B, C, E, D 

Diff: 1 

Objective:  Multiple objectives 
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85) Match the following parts of an Access window to their descriptions: 

I. Navigation Pane 

II. Ribbon 

II. title bar 

IV. Field Properties pane 

V.  Backstage view 

 

A. provides access to database tools such as Save, Save As, and Print 

B. contains details of each field 

C. displays full path name and file name 

D. area that organizes and lists database objects 

E. includes five tabs 

Answer:  D, E, C, B, A 

Diff: 2 

Objective:  Multiple objectives 

86) Match the following keys to their functions: 

I. F11 

II. F2 

II. Tab 

IV. Home 

V.  Esc 

 

A. moves insertion point right one field in the same row of a database 

B. moves insertion point to the first field in the current row of a database 

C. cancels any change made in a current field while in Edit mode 

D. toggles the Navigation Pane on and off 

E. switch to Edit mode 

Answer:  D, E, A, B, C 

Diff: 2 

Objective:  2.  Use an existing database 
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87) Match the following keystrokes to their functions: 

I. Ctrl+End 

II. Ctrl+Z 

II. Shift+Tab 

IV. Ctrl+plus sign (+) 

V.  Ctrl+minus sign (-) 

 

A. moves insertion point to the last field in the last row 

B. moves insertion point left one field in the same row 

C. reverses the last edit 

D. moves to a new record row 

E. deletes the current record 

Answer:  A, C, B, D, E 

Diff: 2 

Objective:  2.  Use an existing database 

 

88) Match the following terms to their meanings: 

I. ascending 

II. descending 

III. field properties 

IV. primary key 

V. AutoNumber 

 

A. field that is unique 

B. define the characteristics for more detail 

C. generated by Access and is automatically incremented each time a record is added 

D. sorts a list of numeric data in lowest to highest order 

E. sorts a list of text data in Z to A order 

Answer:  D, E, B, A, C 

Diff: 1 

Objective:  Multiple objectives 

89) Match the following terms to their meanings: 

I. criterion 

II. filter 

III. normalization 

IV. comparison operator 

V. foreign key 

 

A. process of grouping data into correct tables 

B. display of a subset of records 

C. evaluates the relationship between two quantities 

D. number, text phrase, or expression used to select records from a table 

E. a field in one table that is the primary key in another table 

Answer:  D, B, A, C, E 

Diff: 2 

Objective:  Multiple objectives 
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90) Match the following tabs to their features: 

I. File tab 

II. Home tab 

III. Create tab 

IV. External Data tab 

V. Database Tools tab 

 

A. provides access to the Compact and Repair Database button 

B. access to Backstage view 

C. contains basic editing functions and formatting tools 

D. contains tools used to make new objects 

E. facilitates data import and export 

Answer:  B, C, D, E, A 

Diff: 3 

Objective:  Multiple objectives 

 

91) Offer three examples of interactions that you may have had with databases (knowingly or 

unknowingly) within the last week. 

Answer:  Students answers will vary. Some examples may include registering for classes at their 

college or university, purchasing items from Amazon or another company online, or searching 

for a book at the college, university, or municipal library. 

Diff: 1 

Objective:  1.  Understand database fundamentals 

 

92) Explain a query in Access. Provide an example. 

Answer:  A query is a question that you ask of the data in a database. Student answers will vary. 

One example is how many students passed an exam with 75% or higher?  

Diff: 1 

Objective:  1.  Understand database fundamentals 

 

93) Which view in Excel is most similar to an Excel spreadsheet? What can you do in this view? 

Answer:  The Datasheet view is a grid containing fields (columns) and records (rows), similar to 

an Excel spreadsheet. You can view, add, edit, and delete records in the Datasheet view. 

Diff: 2 

Objective:  1.  Understand database fundamentals 

94) What is one limit to two users working on the same database file at the same time? 

Answer:  Student answers may vary. One limit is that two users can work on the same table as 

long as they are not working on the same record. Another limit is that the same record cannot be 

changed at the same time. 

Diff: 2 

Objective:  2.  Use an existing database 
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95) Describe how Access sorts multiple criteria in a database. 

Answer:  Access sorts multiple criteria by first sorting the column on the left. The column 

immediately to the right of that column is sorted next. Therefore, you must arrange your columns 

in this order. 

Diff: 3 

Objective:  3.  Sort table data on one or multiple fields 

 

96) Describe comparison operators in Access. 

Answer:  A comparison operator is used to evaluate the relationship between two quantities. If 

they are not equal, a comparison operator determines which one is greater than the other. 

Comparison operators include =, < >, >, <, >=, and <=. 

Diff: 2 

Objective:  4.  Create, modify, and remove filters 

 

97) How is referential integrity helpful? 

Answer:  When you enforce referential integrity, Access ensures that data cannot be entered into 

a related table unless it first exists in the primary table. This helps to ensure that data in a 

database is more accurate. It also prohibits users from deleting a record in one table if it has 

records in related tables. 

Diff: 3 

Objective:  6.  Understand relational power 

 

98) What is a foreign key? Provide an example. 

Answer:  A foreign key is a field in one table that is also the primary key of another table. A 

StudentID field (primary key) in a Registration table is joined to the StudentID field (foreign 

key) in a StuAddress table. 

Diff: 3 

Objective:  6.  Understand relational power 

 

99) What is an Access Web app? 

Answer:  An Access Web app is a new type of database that allows you to build a browser-based 

database application. You can create a database that lives in the cloud so that you can access and 

share the database simultaneously with others. 

Diff: 3 

Objective:  7.  Create a database 

 

100) What are the three methods for creating a new database? 

Answer:  You can create a custom Web app, a blank desktop database, or a database from a 

template.  

Diff: 2 

Objective:  7.  Create a database 
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Exploring Microsoft Excel 2013, Comprehensive (Poatsy) 

Chapter 1  Introduction to Excel: What Is a Spreadsheet? 

 

1) A spreadsheet is: 

A) the core of a slide presentation. 

B) an electronic file that is used to write text and graphics on the Web. 

C) an electronic file of a grid of columns and rows of related data. 

D) another word for a letter written on a computer. 

Answer:  C 

Diff: 1 

Objective:  1.  Explore the Excel window 

 

2) A workbook is defined as: 

A) similar to a spreadsheet but hard copy rather than electronic. 

B) an unchangeable picture of data. 

C) the address of the current cell. 

D) a file containing related worksheets. 

Answer:  D 

Diff: 1 

Objective:  1.  Explore the Excel window 

 

3) Which of the following is NOT a standard interface of Microsoft Office applications? 

A) Quick Access Toolbar 

B) Scroll bars 

C)  Ribbon 

D) Input area 

Answer:  D 

Diff: 2 

Objective:  1.  Explore the Excel window 

 

4) An input area is defined as: 

A) a range of cells containing results based on the output area. 

B) a display of the name of a worksheet within a workbook. 

C) a range of cells containing values for variables used in formulas. 

D) the active cell within a workbook. 

Answer:  C 

Diff: 1 

Objective:  1.  Explore the Excel window 
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5) An output area is defined as: 

A) a region of a worksheet with formulas dependent on values from an input area. 

B) a display of the range name and tab name within a workbook. 

C) a range of cells containing values for variables used in formulas and functions within a 

worksheet. 

D) the active cell on an active worksheet. 

Answer:  A 

Diff: 1 

Objective:  1.  Explore the Excel window 

6) The Formula Bar: 

A) displays the name of a worksheet within a workbook. 

B) is located at the intersection of a column and a row. 

C) identifies the address of the current cell in a worksheet. 

D) displays the formula or contents of an active cell. 

Answer:  D 

Diff: 2 

Objective:  1.  Explore the Excel window 

 

7) What does a sheet tab display? 

A) The worksheet and workbook name 

B) All formulas included on that worksheet 

C) The address of the current cell 

D) The name of a worksheet within a workbook 

Answer:  D 

Diff: 2 

Objective:  1.  Explore the Excel window 

 

8) A cell address: 

A) identifies the active cell and worksheet. 

B) identifies a cell by a column letter and a row number. 

C) contains a column letter, a row number, and a worksheet tab name. 

D) identifies a worksheet by its column letter and row number. 

Answer:  B 

Diff: 2 

Objective:  1.  Explore the Excel window 

 

9) To display a long text label on two or more lines within a single cell: 

A) type the first line, press Enter, and type the remaining line. 

B) insert a line break with Alt+Enter. 

C) insert a line break with Ctrl+Enter. 

D) use F2 to insert a line break after the first line. 

Answer:  B 

Diff: 2 

Objective:  2.  Enter and edit cell data 
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10) AutoComplete: 

A) adds all numbers in the row automatically. 

B) searches for and displays any other similar label in the current column when you begin 

typing. 

C) adds numbers within a column automatically. 

D) searches for and displays any other similar label in the current row when you begin typing. 

Answer:  B 

Diff: 2 

Objective:  2.  Enter and edit cell data 

11) A value: 

A) controls the sequence in which Excel performs arithmetic operations. 

B) is a number that represents a quantity and can be the basis of calculations. 

C) includes letters, numbers, and spaces. 

D) is a combination of cell references, operators, values, and/or functions used to perform 

calculations. 

Answer:  B 

Diff: 2 

Objective:  2.  Enter and edit cell data 

 

12) Press ________ to enter data into a cell and keep that cell as the active cell. 

A) F2 

B) Ctrl+F2 

C) Shift+F4 

D) Ctrl+Enter 

Answer:  D 

Diff: 3 

Objective:  2.  Enter and edit cell data 

 

13) A formula is: 

A) a number that represents a date and can be the basis of calculations. 

B) a combination of cell references, operators, values, and/or functions used to perform 

calculations. 

C) a number that represents a quantity and can be the basis of calculations. 

D) entered into a cell by pressing F2. 

Answer:  B 

Diff: 2 

Objective:  2.  Enter and edit cell data 

 

14) You should use cell references in formulas instead of constant values so that: 

A) you can easily include letters, numbers, and spaces. 

B) it is easier to debug the errors. 

C) you can change the input values without changing the formulas. 

D) you can control the sequence in which Excel performs arithmetic operations. 

Answer:  C 

Diff: 2 

Objective:  3.  Create formulas 
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15) The order of precedence in Excel 2013: 

A) includes letters, numbers, and spaces. 

B) controls the sequence in which Excel performs arithmetic operations. 

C) is a software application used to create and modify business communications. 

D) includes formulas, functions, and formatting. 

Answer:  B 

Diff: 2 

Objective:  3.  Create formulas 

16) Auto Fill in Excel 2013: 

A) enables you to copy the contents of a cell or to continue a sequence by dragging the fill 

handle. 

B) is the fastest way to type A1 in the name box. 

C) is adjustable so you can display more or fewer characters in a column. 

D) helps carry over the fill to the remaining worksheets. 

Answer:  A 

Diff: 2 

Objective:  4.  Use Auto Fill 

 

17) The fill handle: 

A) is a red bolded circle at the bottom-right of an active cell. 

B) helps carry over the fill in an active cell to another range. 

C) is the same action as pressing the Enter key. 

D) is a small green square at the bottom-right corner of a cell. 

Answer:  D 

Diff: 2 

Objective:  4.  Use Auto Fill 

 

18) Using the fill handle on a cell containing a formula: 

A) cannot complete a sequence of dates in a column. 

B) changes the background color of the selected cells to yellow. 

C) copies the formula in the active cell to other cells and adapts it based upon the type of cell 

references in the original formula. 

D) has two or more sub-commands related to the command. 

Answer:  C 

Diff: 2 

Objective:  4.  Use Auto Fill 

 

19) Which of the following is NOT a way to insert a new worksheet? 

A) Click New sheet to the right of the last tab 

B) Press Ctrl+F11 

C) Right-click a tab, select Insert from the shortcut menu, click Worksheet 

D) Click the Insert arrow in the Cells group, select Insert Sheet 

Answer:  B 

Diff: 3 

Objective:  6.  Manage worksheets 
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20) Column width: 

A) is adjustable so you can display more or less characters in a column. 

B) is not adjustable so keep the formulas as short as possible. 

C) always switches back to default. 

D) is best left unchanged unless you absolutely have to. 

Answer:  A 

Diff: 2 

Objective:  7.  Manage columns and rows 

21) Which of the following is NOT a way to unhide column A in a worksheet? 

A) Type A1 in the name box and then press the Enter key 

B) Right-click the hidden column heading and select Unhide 

C) Click Select All and use the Hide & Unhide submenu 

D) Click Unhide on the View tab 

Answer:  D 

Diff: 3 

Objective:  7.  Manage columns and rows 

 

22) A range: 

A) cannot be selected with the mouse. 

B) is the numbers that fall between the smallest and largest in a formula or function. 

C) is another word for the active worksheet. 

D) refers to a group of adjacent or contiguous cells. 

Answer:  D 

Diff: 2 

Objective:  8.  Select, move, copy, and paste data 

 

23) To select a range by using the name box: 

A) click in the name box and type the range address such as B15:D25 and then press Enter. 

B) select the name box from the File menu and choose Range. 

C) position the mouse pointer over the column headings holding the Alt key. 

D) click in the first cell of the range, hold the Ctrl key, and then click in the last cell of the range. 

Answer:  A 

Diff: 3 

Objective:  8.  Select, move, copy, and paste data 

 

24) Copy as Picture can be a useful command when: 

A) you do not have a printer available. 

B) the formulas, functions, and headings need to be tested even if it's been pasted into a Word 

document. 

C) you simply want to paste (and not edit) into a Word document. 

D) you need to edit the data quickly even if it has been pasted into PowerPoint of Word. 

Answer:  C 

Diff: 3 

Objective:  8.  Select, move, copy, and paste data 
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25) The wrap text feature in Excel: 

A) can be downloaded as an add-on to Excel 2013. 

B) enables long formulas to wrap to two or more lines within a single cell. 

C) is most useful with very short titles or column headings. 

D) enables data to appear on two or more lines within a cell. 

Answer:  D 

Diff: 3 

Objective:  9.  Apply alignment and font options 

26) A border: 

A) is data from another cell that is only temporarily residing in an active cell. 

B) is a line that surrounds a cell or a range of cells. 

C) never prints. 

D) is preset and weight cannot be adjusted. 

Answer:  B 

Diff: 1 

Objective:  9.  Apply alignment and font options 

 

27) Which of the following is FALSE pertaining to Excel number formats? 

A) When you apply a number format, you can specify the number of decimal places. 

B) Changing number formats changes the way a number displays in a cell. 

C) Values have no special formatting when you enter data into cells. 

D) The default number format is Comma. 

Answer:  D 

Diff: 3 

Objective:  10.  Apply number formats 

 

28) Which of the following is NOT a number format available in the Number group on the Home 

tab? 

A) Comma Style 

B) Percent Style 

C) Accounting Number Format 

D) Date Format 

Answer:  D 

Diff: 3 

Objective:  10.  Apply number formats 

 

29) Which of the following is NOT an option available on the Page Layout tab of Excel 2013? 

A) Select the print area 

B) Select the number format 

C) Select orientation 

D) Set the margins 

Answer:  B 

Diff: 2 

Objective:  11.  Select page setup options 
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30) The Print Preview feature in Excel 2013 is available: 

A) on the Quick Access Toolbar. 

B) on the Page Layout tab. 

C) in Microsoft Office Backstage view. 

D) on the View tab. 

Answer:  C 

Diff: 2 

Objective:  12.  Preview and print a worksheet 

 

31) By default new workbooks contain three worksheets. 

Answer:  FALSE 

Diff: 1 

Objective:  1.  Explore the Excel window 

32) To begin a formula in a cell, first type the # symbol. 

Answer:  FALSE 

Diff: 1 

Objective:  4.  Use Auto Fill 

 

33) The order of precedence in Excel is the same as the basic order of operations in math. 

Answer:  TRUE 

Diff: 2 

Objective:  4.  Use Auto Fill 

 

34) To display cell formulas, press Ctrl and the asterisk (*). 

Answer:  FALSE 

Diff: 1 

Objective:  5.  Display cell formula 

 

35) In Excel 2013, it is only possible to add a new worksheet when the workbook is created. 

Answer:  FALSE 

Diff: 1 

Objective:  6.  Manage worksheets 

 

36) Double-clicking a worksheet tab allows you to rename the tab. 

Answer:  TRUE 

Diff: 2 

Objective:  6.  Manage worksheets 

 

37) To help manage your worksheets within a workbook, worksheets tabs can be assigned 

unique patterns and even icon pictures. 

Answer:  FALSE 

Diff: 2 

Objective:  6.  Manage worksheets 
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38) When you hide a column or row, the data is not deleted, it is just hidden. 

Answer:  TRUE 

Diff: 1 

Objective:  7.  Manage columns and rows 

 

39) Excel data can be copied and pasted into a Word or PowerPoint document. 

Answer:  TRUE 

Diff: 1 

Objective:  8.  Select, move, copy, and paste data 

 

40) Formatting data makes it difficult to read and tends to obscure meaningful details. 

Answer:  FALSE 

Diff: 1 

Objective:  9.  Apply alignment and font options 

 

41) Once cells have been merged they cannot be unmerged. 

Answer:  FALSE 

Diff: 1 

Objective:  9.  Apply alignment and font options 

42) Text in a cell can by angled clockwise. 

Answer:  TRUE 

Diff: 2 

Objective:  9.  Apply alignment and font options 

 

43) Use horizontal alignment to move data in a cell closer to the top or bottom of the cell. 

Answer:  FALSE 

Diff: 2 

Objective:  9.  Apply alignment and font options 

 

44) Merge & Center is not a good tool for creating titles of headings in Excel. 

Answer:  FALSE 

Diff: 2 

Objective:  9.  Apply alignment and font options 

 

45) Changing the number format of a cell changes the value of the number stored in the cell. 

Answer:  FALSE 

Diff: 1 

Objective:  10.  Apply number formats 

 

46) Comma, Date, Time, and Fraction are all number formats available in Excel 2013. 

Answer:  TRUE 

Diff: 1 

Objective:  10.  Apply number formats 
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47) A Special number format allows characters such as hyphens. 

Answer:  TRUE 

Diff: 1 

Objective:  10.  Apply number formats 

 

48) The Date number format only allows Long Date, for example, March 14, 2016. 

Answer:  FALSE 

Diff: 1 

Objective:  10.  Apply number formats 

 

49) The Page Setup dialog box contains additional options not found on the Excel Ribbon. 

Answer:  TRUE 

Diff: 1 

Objective:  11.  Select page setup options 

 

50) While it is common to center a worksheet horizontally on a page, it is not possible to center it 

vertically on the page in Excel 2013. 

Answer:  FALSE 

Diff: 2 

Objective:  11.  Select page setup options 

 

51) Default margins on an Excel 2013 worksheet are .75" top and bottom. 

Answer:  TRUE 

Diff: 2 

Objective:  11.  Select page setup options 

52) Column headings or row labels can be repeated on multiple-page printouts using the Print 

Titles Page Setup option. 

Answer:  TRUE 

Diff: 2 

Objective:  11.  Select page setup options 

 

53) The &[Page] code used in a cell displays the number of pages in a workbook. 

Answer:  FALSE 

Diff: 2 

Objective:  11.  Select page setup options 

 

54) Excel displays data in gridlines of columns and rows.  Those grid lines always appear on the 

printed document. 

Answer:  FALSE 

Diff: 2 

Objective:  11.  Select page setup options 

 

55) Before printing a worksheet, click the File tab and select Print to preview the worksheet. 

Answer:  TRUE 

Diff: 1 

Objective:  12.  Preview and print a worksheet 
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56) The ________ Toolbar allows a user to quickly save, undo, and redo or repeat commands in 

Excel 2013. 

Answer:  Quick Access 

Diff: 2 

Objective:  1.  Explore the Excel window 

 

57) The ________ of a workbook displays the file name as well as the software name. 

Answer:  title bar 

Diff: 2 

Objective:  1.  Explore the Excel window 

 

58) A(n) ________ is a single spreadsheet. 

Answer:  worksheet 

Diff: 1 

Objective:  1.  Explore the Excel window 

 

59) The ________ button on a worksheet appears as a triangle at the intersection of the row and 

column headings. 

Answer:  Select All 

Diff: 3 

Objective:  1.  Explore the Excel window 

 

60) The ________ bar displays information about a selected command or operation in progress. 

Answer:  Status 

Diff: 2 

Objective:  1.  Explore the Excel window 

61) The ________ command is helpful for navigating to a cell that is not visible onscreen. 

Answer:  Go To 

Diff: 3 

Objective:  2.  Enter and edit cell data 

 

62) To display a different worksheet click the sheet ________ at the bottom of the workbook 

window. 

Answer:  tab 

Diff: 2 

Objective:  1.  Explore the Excel window 

 

63) A number that represents a quantity or amount is called a(n) ________. 

Answer:  value 

Diff: 2 

Objective:  2.  Enter and edit cell data 
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64) A combination of cell references, arithmetic operations, values, and/or functions used in 

calculations is called a(n) ________. 

Answer:  formula 

Diff: 3 

Objective:  2.  Enter and edit cell data 

 

65) For Excel to recognize a formula, it must start with a(n) ________ sign. 

Answer:  equal OR = 

Diff: 1 

Objective:  3.  Create formulas 

 

66) The order of ________ controls the sequence in which Excel does math. 

Answer:  precedence 

Diff: 3 

Objective:  3.  Create formulas 

 

67) You can copy the contents of a cell or a range of cells by dragging the ________. 

Answer:  fill handle 

Diff: 2 

Objective:  4.  Use Auto Fill 

 

68) Use ________ to complete a sequence in a worksheet such as January, February, March, and 

April. 

Answer:  Auto Fill 

Diff: 3 

Objective:  4.  Use Auto Fill 

 

69) The Show Formulas button is accessible from the ________ tab. 

Answer:  Formulas 

Diff: 2 

Objective:  5.  Display cell formula 

 

70) Click Format in the Cells group on the ________ tab to change the color of a worksheet tab. 

Answer:  Home 

Diff: 1 

Objective:  6.  Manage worksheets 

71) Adjust the column ________ to accommodate the widest entry in a column. 

Answer:  width 

Diff: 1 

Objective:  7.  Manage columns and rows 

 

72) If you select cells R45:S46 and T49:V53 you have selected a(n) ________ range. 

Answer:  nonadjacent 

Diff: 2 

Objective:  8.  Select, move, copy, and paste data 
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73) Use the ________ to select a range by clicking in it and typing a range address, and then 

pressing Enter. 

Answer:  Name Box 

Diff: 3 

Objective:  8.  Select, move, copy, and paste data 

 

74) When you've selected and subsequently cut the range, it is copied to the ________. 

Answer:  Clipboard 

Diff: 2 

Objective:  8.  Select, move, copy, and paste data 

 

75) If you enter data into a worksheet and decide you want the columns and rows reversed, you 

can click the Paste arrow, and then click ________. 

Answer:  Transpose 

Diff: 3 

Objective:  8.  Select, move, copy, and paste data 

 

76) ________ refers to how data are positioned in cells. 

Answer:  Alignment 

Diff: 2 

Objective:  9.  Apply alignment and font options 

 

77) The default number format in Excel 2013 is ________. 

Answer:  General 

Diff: 3 

Objective:  10.  Apply number formats 

 

78) The ________ format includes an optional dollar sign placed immediately to the left of a 

number. 

Answer:  Currency 

Diff: 2 

Objective:  10.  Apply number formats 

 

79) The ________ feature on in Page Setup displays a list to set or clear a print area on a 

worksheet. 

Answer:  Print Area 

Diff: 3 

Objective:  11.  Select page setup options 

 

80) The ________ view displays print options and displays a worksheet in print preview mode. 

Answer:  Office Backstage 

Diff: 3 

Objective:  12.  Preview and print a worksheet 
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81) Match the following terms to their meanings: 

I. spreadsheet 

II. Title bar 

III. worksheet 

IV. workbook 

V. Ribbon 

 

A. electronic file that contains a grid of columns and rows 

B. contains file name and software name 

C. commands organized into groups 

D. file containing related worksheets 

E. spreadsheet that contains formulas, functions, values, etc. 

Answer:  A, B, E, D, C 

Diff: 1 

Objective:  1.  Explore the Excel window 

 

82) Match the parts of the Excel Window to their meanings: 

I. Name Box 

II. Formula Bar 

III. sheet tab 

IV. Select All 

V. active cell  

 

A. displays the contents of the active cell 

B. displays the name of a worksheet within a workbook 

C. current cell indicated by a dark green border 

D. identifier that displays the address of the current cell 

E. intersection of a column or row 

Answer:  D, A, B, E, C 

Diff: 1 

Objective:  Multiple objectives 

 

83) Match the following terms to their meanings: 

I. F2 

II. Shift+F11 

III. text 

IV. value 

V. formula 

 

A. number that represents a quantity used for calculations  

B. combination of cell references, operators, values, and/or functions to perform a calculation 

C. combination of letters, numbers, symbols 

D. insert a new worksheet 

E. make changes to cell contents 

Answer:  E, D, C, A, B 

Diff: 1 

Objective:  Multiple objectives 
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84) Match the following terms to their meanings: 

I. Page Number 

II. Orientation 

III. Accounting 

IV. Vertical 

V. Concatenation 

 

A. Header and Footer element 

B. Number format 

C. Page Setup command 

D. Alignment option 

E. Order of precedence 

Answer:  A, C, B, D, E 

Diff: 2 

Objective:  1.  Explore the Excel window 

 

85) Match the keystrokes to their descriptions: 

I. Page Up 

II. Page Down 

III. Tab 

IV. Ctrl+Home 

V. Ctrl+End 

 

A. move insertion point up one screen  

B. move insertion point down one screen 

C. move right one cell in the same row 

D. move insertion point to cell A1 

E. move insertion point to the last active corner in the worksheet 

Answer:  A, B, C, D, E 

Diff: 2 

Objective:  1.  Explore the Excel window 

 

86) Match the type of data that can be entered into a cell with its description: 

I. text 

II. values 

III. dates 

IV. formulas 

V. AutoComplete 

 

A. 3-Oct-16, for example 

B. Quarter 1, for example 

C. cell references, arithmetic operations, and values used in calculations 

D. 534.34, for example 

E. displays other labels in that column that match the letters you type 

Answer:  B, D, A, C, E 

Diff: 2 

Objective:  2.  Enter and edit cell data 
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87) Match the following terms to their meanings: 

I. formulas 

II. semi-selection 

III. starts all formulas 

IV. A2+A3 

V. =C24*D24 

 

A. pointing to cells when building a formula 

B. change static numbers into meaningful results 

C. text 

D. formula 

E. equal sign (=) 

Answer:  B, A, E, C, D 

Diff: 2 

Objective:  3.  Create formulas 

 

88) Match the arithmetic operators in order of precedence: 

I. Parentheses 

II. Exponent 

III. Multiplication 

IV. Division 

V. Addition 

 

A. 3rd in order of precedence 

B. 1st in order of precedence 

C. 4th in order of precedence 

D. 5th in order of precedence 

E. 2nd in order of precedence 

Answer:  B, E, A, C, D 

Diff: 2 

Objective:  3.  Create formulas 

 

89) Match the following terms to their meanings: 

I. fill pointer 

II. series of pound signs 

III. Auto Fill 

IV. fill handle 

V. display cell formulas 

 

A. thin black plus sign 

B. cell is too narrow to display a full value 

C. Ctrl + ` combination 

D. copying the contents of a cell or range by dragging 

E. small square at the bottom-right corner of a cell 

Answer:  A, B, D, E, C 

Diff: 3 

Objective:  Multiple objectives 
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90) Match the following terms to their meanings: 

I. range 

II. Copy as Picture command 

III. nonadjacent range 

IV. Copy 

V. select all cells in a worksheet 

 

A. C10:C20 and E10:E20 

B. default copy option 

C. cannot edit individual cell data 

D. press Ctrl+A twice 

E. group of adjacent or contiguous cells 

Answer:  E, C, A, B, D 

Diff: 3 

Objective:  8.  Select, move, copy, and paste data 

 

91) When B5 is the active cell and you press Ctrl+Enter, what happens? 

Answer:  The label, value, or formula is entered into cell B5 and B5 remains the active cell. 

Diff: 2 

Objective:  2.  Enter and edit cell data 

 

92) Briefly describe the data type "Text." Provide one or two examples of text entries in an Excel 

worksheet.  

Answer:  Text is any combination of letters, numbers, symbols, and spaces not used in 

calculations. Worksheet titles such as "Juan's Taqueria Quarterly Sales" or a social security 

number such as 123-45-6789 are text entries. 

Diff: 2 

Objective:  3.  Create formulas 

 

93) If you have =D5*E5 in cell F5 and want to copy that down to F6 through F12, assuming data 

is contained in cells D6:E12, what is the quickest and easiest way to do that? 

Answer:  Click in cell F5, place your cursor over the fill handle until the cursor changes to a 

small, black plus sign. Double-click the fill handle to quickly copy the formula down through 

cell F12. 

Diff: 2 

Objective:  4.  Use Auto Fill 

 

94) Describe a nonadjacent range, provide an example, and describe how to select a nonadjacent 

range. 

Answer:  A nonadjacent range contains two or more cells or ranges that are not touching each 

other; for example, C10:C13 and E15:E25. Select the first range, press and hold Ctrl, and select 

the additional range or ranges. 

Diff: 2 

Objective:  8.  Select, move, copy, and paste data 
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95) Describe alignment in relation to Excel 2013. How is text automatically aligned, how are 

values automatically aligned, and how are dates automatically aligned? 

Answer:  Alignment refers to how data are positioned in cells. Text aligns at the left cell margin, 

and dates and values align at the right cell margin. 

Diff: 2 

Objective:  9.  Apply alignment and font options 

96) How do the Comma, Accounting, and Currency formats differ? 

Answer:  The Comma format includes the comma as a separator for numbers of 1,000 and over. 

The Accounting format includes a dollar sign placed at the left border of the cell. The Currency 

format includes a dollar sign placed immediately to the left of the number. 

Diff: 2 

Objective:  10.  Apply number formats 

 

97) Why would you want to use the Increase Decimal or Decrease Decimal buttons on the Home 

tab? 

Answer:  Use Increase Decimal or Decrease Decimal on the Home tab to display more decimal 

places for greater or lesser precision. If, for example, a whole column contains whole dollar 

values and no cents, displaying .00 down the column looks cluttered. It is also important for 

number formats to be consistent and decreasing or increasing decimal places can keep numbers 

consistent in a row, column, or range. 

Diff: 3 

Objective:  10.  Apply number formats 

 

98) Describe page orientation when printing. What is the default and in what circumstances may 

you want to change orientation? 

Answer:  Orientation displays the orientation of the physical page--portrait, for worksheets with 

more rows than columns, and landscape, for worksheets with more columns than can fit in 

portrait orientation. Portland orientation is the default. Landscape orientation is more appropriate 

when a worksheet has many columns and fewer rows. 

Diff: 2 

Objective:  11.  Select page setup options 

 

99) Describe three features available for headers and/or footers. 

Answer:  A header and/or footer can appear at the top and/or bottom of every printed page of a 

workbook. You can create different headers or footers on different pages. You can create a 

header or footer that is different on the first page than on all other pages. You can also include 

your name, the date of the worksheet, and page numbers. 

Diff: 3 

Objective:  11.  Select page setup options 
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100) How would you print multiple worksheets? 

Answer:  To print multiple worksheets, click the first sheet tab, press and hold Shift, and then 

click the last sheet tab. If you choose to select nonadjacent sheets, press and hold Ctrl as you 

click each sheet tab. When Print options display in Microsoft Office Backstage view, choose 

Print Active Sheets. 

Diff: 3 

Objective:  12.  Preview and print a worksheet 
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Exploring Microsoft PowerPoint 2013, Comprehensive (Poatsy) 

PowerPoint Chapter 1  Introduction to PowerPoint: Creating a Basic Presentation 

 

1) Which of the following is TRUE about PowerPoint 2013? 

A) A PowerPoint presentation is saved with a .ptt extension after the filename. 

B) A page is the most basic element of a PowerPoint presentation. 

C) A PowerPoint slide show can run automatically at a kiosk. 

D) A PowerPoint slide show cannot be displayed on the World Wide Web.  

Answer:  C 

Diff: 2 

Objective:  1.  Use PowerPoint views 

 

2) The default PowerPoint window contains the ________ and ________ pane. 

A) Thumbnails; Slides 

B) Add-Ins; Outline 

C) Slides; View 

D) Slides; Slide Show 

Answer:  A 

Diff: 2 

Objective:  1.  Use PowerPoint views 

 

3) Changing the order of slides or deleting one or more slides is most easily done in ________ 

view. 

A) Presenter 

B) Reading 

C) Slide Sorter 

D) Slide Show  

Answer:  C 

Diff: 2 

Objective:  1.  Use PowerPoint views 

 

4) Which of the following is FALSE about the Slide Show view? 

A) A presentation running in Slide Show view can contain both manual and automatic slide 

transitions. 

B) To end a slide show, press Esc. 

C) The Slide Show view is used to deliver a completed presentation to an audience. 

D) The Slide Show view is new to PowerPoint 2013.  

Answer:  D 

Diff: 2 

Objective:  1.  Use PowerPoint views 
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5) Of the following, ________ is NOT an option on the PowerPoint status bar. 

A) the Fit slide to current window button 

B) a Zoom slider 

C) the Close button 

D) the Zoom level button  

Answer:  C 

Diff: 2 

Objective:  1.  Use PowerPoint views 

6) If you save a presentation with a .pptx file extension, it will open in ________ view in 

PowerPoint 2013. 

A) Presenter 

B) Slide Sorter 

C) Slide Show 

D) Normal  

Answer:  D 

Diff: 2 

Objective:  1.  Use PowerPoint views 

 

7) Which of the following is recommended as the first step in planning a presentation? 

A) Research your audience 

B) Determine the goal 

C) Brainstorm how to deliver your message 

D) Sketch out your thoughts about the presentation  

Answer:  B 

Diff: 2 

Objective:  4.  Plan a presentation 

 

8) A typical storyboard includes sections for all of the following EXCEPT: 

A) the title slide. 

B) the introduction of the topic. 

C) the development of the topics. 

D) animations.  

Answer:  D 

Diff: 1 

Objective:  4.  Plan a presentation 

 

9) It is suggested that a title slide should include a title in ________ words. 

A) two to five 

B) a minimum of six 

C) ten to fifteen 

D) a minimum of fifteen  

Answer:  A 

Diff: 1 

Objective:  4.  Plan a presentation 
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10) It is suggested that you end a presentation with any of the following EXCEPT a: 

A) restatement of the purpose of your presentation. 

B) call to action. 

C) new key thought. 

D) review of your main points. 

Answer:  C 

Diff: 2 

Objective:  4.  Plan a presentation 

11) Which of the following writing style requires more words may make your presentation seem 

flat? 

A) Active voice 

B) Parallel construction 

C) Beginning bullets with a verb 

D) Passive voice  

Answer:  D 

Diff: 2 

Objective:  5.  Assess presentation content 

 

12) Which of the following lists of phrases uses parallel construction? 

A) Turning on the faucet, drinking the water, and turn the faucet off 

B) Went running, walking, and then rode her bike 

C) Mowed the lawn, weeded the flower beds, and put the tools away 

D) She plays volleyball, likes to hike, and runs cross country  

Answer:  C 

Diff: 2 

Objective:  5.  Assess presentation content 

 

13) Which of the following is FALSE about the 7 × 7 guideline for presentations? 

A) It suggests that you use no more than seven words per line. 

B) You may occasionally be forced to exceed this guideline. 

C) It suggests that you try to use no more than seven lines per slide. 

D) It suggests that a maximum of seven transitions and seven animations should be used in a 

presentation.  

Answer:  D 

Diff: 1 

Objective:  5.  Assess presentation content 

 

14) Choosing the layout for a slide is done by clicking the ________ arrow on the ________ tab. 

A) New Layout; Home 

B) New Slide; Home 

C) New Slide; Insert 

D) Slide; Design  

Answer:  B 

Diff: 2 

Objective:  5.  Assess presentation content 
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15) If you have a Title slide selected and you click on the New Slide button (not the New Slide 

arrow), the new slide will have a ________ layout. 

A) Title and Content 

B) Title Slide 

C) Blank 

D) Title Only 

Answer:  A 

Diff: 2 

Objective:  5.  Assess presentation content 

16) Which of the following is TRUE about themes in PowerPoint 2013? 

A) A theme can be added from the Insert tab. 

B) Widescreen themes are available. 

C) A theme includes animation and transitions. 

D) A theme is automatically applied to only the currently selected slide. 

Answer:  B 

Diff: 3 

Objective:  4.  Plan a presentation 

 

17) Which of the following is a variation of a specific theme design using different color 

palettes? 

A) Templates 

B) Variants 

C) Clip Art 

D) Theme Gallery 

Answer:  B 

Diff: 2 

Objective:  4.  Plan a presentation 

 

18) Which of the following is NOT considered a step in checking spelling and incorrect word 

usage in a PowerPoint slide show? 

A) Use the Editing feature. 

B) Read the slide content after you enter it. 

C) Use the Spelling feature. 

D) Ask a friend or colleague to review it. 

Answer:  A 

Diff: 2 

Objective:  6.  Review the presentation 

 

19) Contextual mistakes in PowerPoint 2013 are noted by: 

A) a red wavy underline. 

B) dark red bolded text. 

C) a thick green underline. 

D) blue flashing text.  

Answer:  A 

Diff: 2 

Objective:  6.  Review the presentation 
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20) All of the following layouts include specific buttons to quickly and easily insert objects 

EXCEPT: 

A) Title and Content. 

B) Title Slide. 

C) Comparison. 

D) Content with Caption. 

Answer:  B 

Diff: 1 

Objective:  7.  Insert media objects 

21) Which of the following is TRUE about tables in PowerPoint 2013? 

A) Tables organize information on a slide in columns and rows. 

B) Tables are difficult to insert into a slide. 

C) After a table is inserted, columns can be widened, but rows cannot be changed. 

D) PowerPoint can only create simple, uncomplicated tables.  

Answer:  A 

Diff: 2 

Objective:  8.  Add a table 

 

22) The ________ key can be used to move the insertion point from one cell of a table to the 

next. 

A) Insert 

B) Tab 

C) F2 

D) Enter  

Answer:  B 

Diff: 2 

Objective:  8.  Add a table 

 

23) What key combination inserts an indent within the cell of a table in PowerPoint 2013? 

A) Shift+Tab 

B) Alt+Tab 

C) Ctrl+right arrow 

D) Ctrl+Tab  

Answer:  D 

Diff: 2 

Objective:  8.  Add a table 
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24) Animation is movement that controls all of the following elements EXCEPT the ________ 

of an object in a slide show. 

A) transition 

B) exit 

C) entrance 

D) path  

Answer:  A 

Diff: 1 

Objective:  9.  Use animations and transitions 

 

25) In which views does a transition appear? 

A) Presentation and Notes views 

B) Normal and Presentation views 

C) Normal and Slide Show views 

D) Slide Show and Reading views  

Answer:  D 

Diff: 2 

Objective:  9.  Use animations and transitions 

26) Appear, Fade, Fly In, and Bounce are all types of: 

A) transitions. 

B) themes. 

C) animations. 

D) templates. 

Answer:  C 

Diff: 2 

Objective:  9.  Use animations and transitions 

 

27) While viewing slides in the Slide Sorter, a(n) ________ icon indicates that a slide has 

animation. 

A) arrow 

B) check mark 

C) red circle 

D) star  

Answer:  D 

Diff: 2 

Objective:  9.  Use animations and transitions 

 

28) Which of the following is TRUE about transitions and animations? 

A) The more transitions you can include on a slide, the better the presentation. 

B) Very slow transitions are calming and work well for all types of audiences. 

C) When transitions are part of a slide, you cannot delete just one transition; all transitions must 

be deleted. 

D) Too many transitions and animation styles can be distracting for audiences.  

Answer:  D 

Diff: 2 

Objective:  9.  Use animations and transitions 
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29) What does checking the Update Automatically button do in the Header and Footer dialog 

box? 

A) It automatically updates the date to always be current. 

B) It automatically updates edited text within a footer. 

C) It updates the header or footer when the file is saved. 

D) It updates the header and footer positions if you change slide theme.  

Answer:  A 

Diff: 1 

Objective:  10.  Insert a header of footer 

 

30) Of the following, which is NOT a method to advance through a slide show? 

A) Press the Spacebar 

B) Press Page Down 

C) Press P 

D) Press Enter  

Answer:  C 

Diff: 2 

Objective:  11.  Run and navigate a slide show 

31) Of the following, which is NOT a method to return to a previously viewed slide? 

A) Press N 

B) Press the left arrow 

C) Press Backspace 

D) Press Page Up  

Answer:  A 

Diff: 2 

Objective:  11.  Run and navigate a slide show 

 

32) When in Slide Show view, you can zoom into a section of the slide by clicking the: 

A) forward arrow. 

B) back arrow. 

C) zoom slider button. 

D) magnifying glass icon button. 

Answer:  D 

Diff: 2 

Objective:  11.  Run and navigate a slide show 

 

33) The ________ key darkens the screen during a presentation. 

A) D 

B) Esc 

C) B 

D) F12  

Answer:  C 

Diff: 2 

Objective:  11.  Run and navigate a slide show 
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34) Which of the following keys will NOT navigate forward or backward while in Slide Show 

view? 

A) N and P 

B) Shift and Ctrl 

C) Spacebar and Backspace 

D) Page Down and Page Up  

Answer:  B 

Diff: 2 

Objective:  11.  Run and navigate a slide show 

 

35) What tab should be accessed in order to print a slide show? 

A) File 

B) Home 

C) Insert 

D) Review  

Answer:  A 

Diff: 1 

Objective:  12.  Print in PowerPoint 

36) What happens to the background when you print a slide show in grayscale? 

A) The background prints in shades of gray. 

B) The background will only print in black and white; no shades will be included. 

C) The background will not print. 

D) An error message occurs.  

Answer:  C 

Diff: 2 

Objective:  12.  Print in PowerPoint 

 

37) Which of the following is NOT an option when clicking the Full Page Slides button? 

A) Scale to Fit 

B) High Quality 

C) Grayscale 

D) Frame  

Answer:  C 

Diff: 3 

Objective:  12.  Print in PowerPoint 

 

38) Which of the following is NOT a handout printing option? 

A) One 

B) Two 

C) Six 

D) All  

Answer:  D 

Diff: 2 

Objective:  12.  Print in PowerPoint 
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39) Which of the following is TRUE about printing the outline of a slide show? 

A) Speaker notes are not included when printed. 

B) All charts and graphics would also be included in the printout. 

C) Slide titles are never included when printing an outline. 

D) Printing the outline will include all details, all bullets, all graphics, and all tables.  

Answer:  A 

Diff: 2 

Objective:  12.  Print in PowerPoint 

 

40) Which of the following PowerPoint feature is accessed through the File tab? 

A) Print 

B) Slide Orientation 

C) New Slide 

D) Header & Footer 

Answer:  A 

Diff: 1 

Objective:  12.  Print in PowerPoint 

 

41) The Normal view is the default view in PowerPoint 2013. 

Answer:  TRUE 

Diff: 2 

Objective:  1.  Use PowerPoint views 

42) All PowerPoint views are available on the status bar. 

Answer:  FALSE 

Diff: 2 

Objective:  1.  Use PowerPoint views 

 

43) Notes in the Notes Page view appear when a presentation is displayed for an audience. 

Answer:  FALSE 

Diff: 2 

Objective:  2.  Type a speaker note 

 

44) In Reading view, the status bar includes navigation buttons to move to the next or previous 

slide in a presentation. 

Answer:  TRUE 

Diff: 2 

Objective:  1.  Use PowerPoint views 

 

45) Both .pptx and .ppsx are PowerPoint 2013 file extensions. 

Answer:  TRUE 

Diff: 2 

Objective:  3.  Save as a slide show 
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46) Each key thought of a presentation should be a separate, new slide. 

Answer:  TRUE 

Diff: 2 

Objective:  4.  Plan a presentation 

 

47) A storyboard can simply be a rough draft of your initial thoughts about your presentation. 

Answer:  TRUE 

Diff: 2 

Objective:  4.  Plan a presentation 

 

48) It is never a good idea to repeat your contact information at the end of a presentation. 

Answer:  FALSE 

Diff: 2 

Objective:  4.  Plan a presentation 

 

49) After you have created a storyboard, it is advisable to lengthen sentences and add adverbs 

and adjectives to your text. 

Answer:  FALSE 

Diff: 2 

Objective:  5.  Assess presentation content 

 

50) In regard to parallel construction, if you start your first bullet with a noun, each successive 

bullet should start with a noun. 

Answer:  TRUE 

Diff: 2 

Objective:  5.  Assess presentation content 

 

51) To keep your slide content concise, you should follow the 15X15 guideline. 

Answer:  FALSE 

Diff: 2 

Objective:  5.  Assess presentation content 

52) You must create all of your own layouts within PowerPoint 2013. 

Answer:  FALSE 

Diff: 1 

Objective:  5.  Assess presentation content 

 

53) The Blank slide layout includes only a placeholder for the title. 

Answer:  FALSE 

Diff: 2 

Objective:  5.  Assess presentation content 

 

54) When creating slides, you would normally first add content to a placeholder, and then select 

a layout. 

Answer:  FALSE 

Diff: 2 

Objective:  5.  Assess presentation content 
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55) You must delete all unused placeholders on a slide since they will show when you run the 

slide show. 

Answer:  FALSE 

Diff: 2 

Objective:  5.  Assess presentation content 

 

56) When you apply a theme, it is automatically applied to only the current slide that you have 

selected. 

Answer:  FALSE 

Diff: 3 

Objective:  4.  Plan a presentation 

 

57) The Spelling feature in PowerPoint 2013 will catch contextual errors such as "there" and 

"their." 

Answer:  FALSE 

Diff: 2 

Objective:  6.  Review the presentation 

 

58) PowerPoint 2013 includes a Thesaurus feature. 

Answer:  TRUE 

Diff: 1 

Objective:  6.  Review the presentation 

 

59) The Two Content slide layout offers a placeholder for easily inserting a media object.  

Answer:  TRUE 

Diff: 2 

Objective:  7.  Insert media objects 

 

60) A table can only be inserted on a slide layout that includes an automatic placeholder for a 

table. 

Answer:  FALSE 

Diff: 2 

Objective:  8.  Add a table 

 

61) A table can include both text as well as images. 

Answer:  TRUE 

Diff: 2 

Objective:  8.  Add a table 

62) Transitions can be applied to multiple slides from the Slide Sorter view. 

Answer:  TRUE 

Diff: 2 

Objective:  9.  Use animations and transitions 
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63) All header and footer fields are positioned in the same place on all templates. 

Answer:  FALSE 

Diff: 2 

Objective:  10.  Insert a header of footer 

 

64) The Zoom box command allows you to magnify a section of a slide while presenting a slide 

show. 

Answer:  FALSE 

Diff: 2 

Objective:  11.  Run and navigate a slide show 

 

65) The most basic element of a PowerPoint slide show is a(n) ________, which is similar to a 

page being the most basic element of Microsoft Word. 

Answer:  slide  

Diff: 1 

Objective:  1.  Use PowerPoint views 

 

66) A(n) ________ is a small, miniature graphic of a slide that appears in the Slides tab. 

Answer:  thumbnail  

Diff: 2 

Objective:  1.  Use PowerPoint views 

 

67) A(n) ________ is a variation of the theme you have chosen.  

Answer:  variant  

Diff: 2 

Objective:  4.  Plan a presentation 

 

68) ________ view is the two-pane PowerPoint default view. 

Answer:  Normal  

Diff: 2 

Objective:  1.  Use PowerPoint views 

 

69) Saving a presentation as a PowerPoint ________ will allow the file to automatically open in 

Slide Show view. 

Answer:  show  

Diff: 2 

Objective:  2.  Type a speaker note 

 

70) A(n) ________ is a visual plan of a presentation that helps in planning the direction of your 

presentation. 

Answer:  storyboard  

Diff: 2 

Objective:  4.  Plan a presentation 
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71) "Accurate and swift typing is a skill needed by students" is an example of ________ voice 

and should be primarily avoided on slides. 

Answer:  passive  

Diff: 3 

Objective:  5.  Assess presentation content 

 

72) The slide ________ determines the location and presence or absence of objects contained on 

a slide. 

Answer:  layout  

Diff: 2 

Objective:  6.  Review the presentation 

 

73) A(n) ________ holds content, such as a title, subtitle, or an image. 

Answer:  placeholder  

Diff: 3 

Objective:  6.  Review the presentation 

 

74) After determining your purpose and researching your audience, ________ how to deliver 

your message.  

Answer:  brainstorm 

Diff: 2 

Objective:  4.  Plan a presentation 

 

75) Clicking ________, and then the Options button will allow you to set the Proofing options in 

PowerPoint 2013. 

Answer:  File  

Diff: 3 

Objective:  6.  Review the presentation 

 

76) The ________ tab allows you to include a media object in your presentation. 

Answer:  Insert  

Diff: 2 

Objective:  7.  Insert media objects 

 

77) A(n) ________ structures information in columns and rows on a slide. 

Answer:  table 

Diff: 2 

Objective:  8.  Add a table 

 

78) Press the Shift + ________ keys to move the insertion point from one cell of a table to the 

previous cell. 

Answer:  Tab 

Diff: 2 

Objective:  8.  Add a table 
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79) Pressing the ________ key when the insertion point is in the last cell of a table will insert a 

new row in the table. 

Answer:  Tab  

Diff: 2 

Objective:  8.  Add a table 

80) A(n) ________ is movement applied to an object or text, which is viewable in Slide Show 

view. 

Answer:  animation  

Diff: 2 

Objective:  9.  Use animations and transitions 

 

81) A(n) ________ is movement that occurs between slides and how one slide replaces another. 

Answer:  transition  

Diff: 2 

Objective:  9.  Use animations and transitions 

 

82) If you want the same information to be included at the bottom of each page of a handout or 

notes page given to the audience, create a(n) ________. 

Answer:  footer  

Diff: 1 

Objective:  10.  Insert a header of footer 

 

83) A(n) ________ generally appears at the top of slides and offers consistent text and/or 

graphics on each slide. 

Answer:  header 

Diff: 1 

Objective:  10.  Insert a header of footer 

 

84) Press the ________ key during a presentation to see a list of slide show controls. 

Answer:  F1  

Diff: 2 

Objective:  12.  Print in PowerPoint 

 

85) A written note or drawing that offers additional commentary or explanation and is written 

during a slide show is known as a(n) ________. 

Answer:  annotation  

Diff: 2 

Objective:  12.  Print in PowerPoint 

 

86) The default orientation for printing slides is ________. 

Answer:  landscape  

Diff: 2 

Objective:  12.  Print in PowerPoint 
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87) The ________ slides option includes a black border around slides when printed. 

Answer:  Frame  

Diff: 3 

Objective:  12.  Print in PowerPoint 

 

88) The ________ option ensures that slides fit within the paper size no matter what the slide 

size. 

Answer:  Scale to Fit  

Diff: 3 

Objective:  12.  Print in PowerPoint 

89) Match the following views in PowerPoint 2013 with their function: 

I. Notes Page view 

II. Slide Sorter view 

III. Slide Show view 

IV. Reading view 

V. Presenter view 

 

A. deliver a presentation on two monitors simultaneously 

B. view one slide at a time with a title bar and Close button 

C. enter and edit large amounts of text for the speaker to refer to 

D. view multiple slides at one time 

E. deliver the final presentation to an audience 

Answer:  C, D, E, B, A 

Diff: 2 

Objective:  Multiple objectives 

 

90) Match the following parts of the PowerPoint interface with their function: 

I. Slides tab 

II. Slide pane 

III. Notes pane 

IV. status bar 

V. splitter bar 

 

A. add and edit text for use by the speaker  

B. contains the slide number, theme name, and view options in Normal view 

C. shows slide thumbnails 

D. changes the size of your panes 

E. edit the current slide 

Answer:  C, E, A, B, D 

Diff: 1 

Objective:  1.  Use PowerPoint views 
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91) Match the following shortcut keys in PowerPoint 2013 to their function: 

I. Type B in Slide Show view 

II. Esc in Slide Show view 

III. Ctrl+Tab 

IV. Spacebar in Slide Show view 

V. Shift+Tab 

 

A. ends the slide show 

B. advances to the next slide 

C. inserts an indent within a table cell 

D. moves the insertion point within a table to the previous cell 

E. changes the slide to a black slide 

Answer:  E, A, C, B, D 

Diff: 3 

Objective:  Multiple objectives 

92) Match the following views in PowerPoint 2013 with their function: 

I. Notes Page view 

II. Slide Sorter view 

III. Slide Show view 

IV. Reading view 

V. Presenter view 

 

A. deliver a presentation on two monitors simultaneously 

B. view one slide at a time with a title bar and Close button 

C. to enter and edit large amounts of text for the speaker to refer to 

D. view multiple slides at one time 

E. deliver the final presentation to an audience 

Answer:  C, D, E, B, A 

Diff: 2 

Objective:  Multiple objectives 

 

93) Match the PowerPoint feature or function with the tab where it can be accessed: 

I. see slide in a two-pane window 

II. view slides from the first slide 

III. save the file as a PowerPoint Show 

IV. create a new slide 

V. choose a new theme 

 

A. Slide Show tab 

B. View tab 

C. Home tab 

D. Design tab 

E. File tab 

Answer:  B, A, E, C, D  

Diff: 2 

Objective:  Multiple objectives 
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94) Match the PowerPoint option with its description: 

I. Print Full slides option 

II. Grayscale option 

III. Pure Black and White option 

IV. Frame slides option 

V. Scale to Fit paper option 

 

A. prints with black border around each slide  

B. prints without gray fills 

C. prints slides for use as a backup 

D. prints on one page, even if slide is set to a large custom size 

E. prints without the background 

Answer:  C, E, B, A, D  

Diff: 2 

Objective:  Multiple objectives 

95) Match the following terms with their descriptions: 

I. variant 

II. animation 

III. transition 

IV. theme 

V. layout 

 

A. a variation of a theme 

B. movement applied to text or an object 

C. movement applied to slides as one replaces another 

D. determines the position of objects on a slide 

E. designs that include colors and fonts 

Answer:  A, B, C, E, D  

Diff: 1 

Objective:  Multiple objectives 
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96) Match the names of a variety of features with the type of PowerPoint option: 

I. Fade, Wipe, Split 

II. Ion, Facet, Integral 

III. Wipe, Fly In, Fade 

IV. Notes Page, Normal 

V. Blank, Title Only 

 

A. animations 

B. transitions 

C. views 

D. layouts 

E. themes 

Answer:  B, E, A, C, D 

Diff: 2 

Objective:  Multiple objectives 

 

97) Match the navigation method with the navigation option in PowerPoint 2013: 

I. Press N 

II. Press P 

III. Press Esc 

IV. Type a slide number and press Enter  

V. Press F1 

 

A. returns to a previous slide 

B. ends a slide show 

C. shows a list of slide show controls 

D. advance through the slide show 

E. goes to a specific slide 

Answer:  D, A, B, E, C  

Diff: 2 

Objective:  12.  Print in PowerPoint 

98) Match the following terms with their descriptions: 

I. placeholder 

II. layout 

III. file with .ppsx extension 

IV. slide show 

V. file with .pptx extension 

 

A. container that holds content on a slide 

B. PowerPoint show 

C. multiple slides 

D. PowerPoint presentation 

E. determines the position of objects and text on a slide 

Answer:  A, E, B, C, D  

Diff: 2 

Objective:  Multiple objectives 
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99) Why is it a good idea to use Speaker notes when creating and giving a PowerPoint 

presentation? 

Answer:  You can make bulleted lists and highlight items you want your audience to remember. 

Speaker notes can help to enhance your presentation and make it appear more professional. You 

never want to read verbatim what is presented on your slides.  

Diff: 2 

Objective:  2.  Type a speaker note 

 

100) What is a storyboard, and why is it a good idea to use one when creating a slide show? 

Answer:  A storyboard is a visual plan that aids in preparing your presentation. A storyboard 

allows you to put your thoughts and ideas on paper and helps to organize your material.  

Diff: 2 

Objective:  4.  Plan a presentation 

 

101) Name two ways in which adding animation can benefit your presentation? 

Answer:  Animation can help focus the audience's attention on a specific important point on a 

slide, and can control the flow of information. It can also make the slides more interesting, 

thereby keeping your audience's attention throughout the presentation.  

Diff: 2 

Objective:  9.  Use animations and transitions 

 

102) What is the purpose of using a table in a presentation?  

Answer:  A table can help to organize information into columns and row. Information in a table 

often makes it easier for an audience to understand and comprehend the concept being presented.  

Diff: 2 

Objective:  8.  Add a table 

 

103) Name three things you should NEVER do during a presentation. 

Answer:  Answers may vary but may include the following: never overwhelm your audience 

with too many animations, sounds, or special effects; never continually stare at your screen; and 

never just read from a prepared script or your PowerPoint notes because you will not appear 

professional.  

Diff: 1 

Objective:  11.  Run and navigate a slide show 

104) Explain why it is important to have a backup plan for your presentation in case of 

equipment failure. What might be two good backup plans? 

Answer:  If your equipment should fail, you would not look very professional if you did not have 

a backup plan. With a backup plan, you will still be able to present your material and get your 

message to your audience. Handouts and overhead transparencies are two good examples of 

backups. 

Diff: 2 

Objective:  11.  Run and navigate a slide show 

 



 

20 

Copyright © 2014 Pearson Education, Inc. 

105) You have created your presentation and decide that you need to reorder some of your slides. 

Name the steps necessary in order to do this. 

Answer:  1. Click the VIEW tab. 

2. Click Slide Sorter in the Presentation Views group. 

3. Select the slide you wish to move and drag the slide to the new location. 

4. Double-click any slide to return to the Normal view.  

Diff: 3 

Objective:  4.  Plan a presentation 

 

106) Explain "Presenter view" and the benefits to using this method in a presentation. 

Answer:  Presenter view is a specialty view that delivers a presentation on two monitors 

simultaneously. Typically, one monitor is a projector that delivers the full-screen presentation to 

the audience; the other monitor is a laptop or computer placed in front of the presenter so that he 

or she can see the slide, speaker notes, and a thumbnail image of the next slide. This enables the 

presenter to move between slides as needed, navigate to the previous or next slide using arrows, 

or write on the slide with a marker. A timer displays the time elapsed since the presentation 

began so that the presenter can keep track of the presentation length.  

Diff: 3 

Objective:  1.  Use PowerPoint views 

 

107) Name three necessary steps you should take prior to planning your presentation. 

Answer:  Answers may vary but may include the following: 

Determine the goal of your presentation; research your audience to determine their level of 

knowledge about your topic; find out the audience's needs, expectations, and level of interest; or 

brainstorm about the best way to deliver your message.  

Diff: 2 

Objective:  4.  Plan a presentation 

 

108) What is the benefit of adding graphics and media objects to a PowerPoint presentation? 

Answer:  By adding graphics and media objects, you can enhance and strengthen your slide 

show, add impact and stress critical concepts, and help catch the audience's attention.  

Diff: 2 

Objective:  7.  Insert media objects 
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Exploring Microsoft Word 2013 Comprehensive (Poatsy) 

Chapter 1  Office Fundamentals and File Management: Taking the First Step 

 

1) An operating system is: 

A) technology used to access files saved in the cloud. 

B) software available only on desktops and laptops, not on tablets or other small, portable 

devices. 

C) software that directs activities of a computer. 

D) an app installed on a desktop or laptop. 

Answer:  C 

Diff: 1 

Objective:  1.  Log in with your Microsoft account 

 

2) After you start your computer and enter your username and password, ________ displays in 

Windows 8. 

A) the desktop 

B) each Charm 

C) the Mini toolbar 

D) the Start screen 

Answer:  D 

Diff: 2 

Objective:  1.  Log in with your Microsoft account 

 

3) Which of the following is an app used to store, access, and share files and folders? 

A) SkyDrive 

B) Windows 8 

C) Snipping Tool 

D) Cloud storage 

Answer:  A 

Diff: 2 

Objective:  1.  Log in with your Microsoft account 

 

4) Which of the following is NOT part of the Windows 8 initial screen display? 

A) User identification in the top-right corner 

B) Tiles 

C) The Start button 

D) The Start screen 

Answer:  C 

Diff: 2 

Objective:  2.  Identify the Start screen components 

 



2 

Copyright © 2014 Pearson Education, Inc. 

5) Which of the following is FALSE about Charms in Windows 8? 

A) There are six icons that make up the Charms in Windows 8. 

B) Charms can be accessed by pointing to the top-right of the screen. 

C) Charms provide similar functionality to the Start button in previous Windows versions. 

D) Charms can be accessed by pointing to the bottom-right of the screen. 

Answer:  A 

Diff: 3 

Objective:  2.  Identify the Start screen components 

6) Which of the following is TRUE about tiles? 

A) New tiles added to the Start screen are added to the beginning of your apps. 

B) Tiles can be dragged to a new location on the Start screen. 

C) Tiles can be pinned to the Start screen but cannot be unpinned. 

D) You can remove a tile from the Start screen by double-clicking it and clicking Unpin from 

Start. 

Answer:  B 

Diff: 3 

Objective:  3.  Interact with the Start screen 

 

7) Which of the following is TRUE about the Notification area of Windows 8? 

A) It doesn't exist in Windows 8. 

B) It is available as a tile on the Start screen. 

C) It is displayed in the bottom-right corner of the desktop. 

D) It is accessible from the Start button. 

Answer:  C 

Diff: 3 

Objective:  4.  Access the desktop 

 

8) If you have not made any changes to the default settings of Windows 8, which icons are 

available on the taskbar? 

A) Internet Explorer and Snipping Tool 

B) File Explorer and Internet Explorer 

C) File Explorer, Internet Explorer, and Microsoft Office 

D) Desktop and Start screen 

Answer:  B 

Diff: 3 

Objective:  4.  Access the desktop 

 

9) Which of the following is NOT an available option for a snip in the Snipping Tool? 

A) Desktop Snip 

B) Free-form Snip 

C) Window Snip 

D) Rectangle Snip 

Answer:  A 

Diff: 3 

Objective:  4.  Access the desktop 
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10) Which of the following is TRUE about files? 

A) Software is used to create folders, not files. 

B) For a file to be accessed at a later time, it must be stored only on the computer's hard drive. 

C) A digital photograph or music can be a file. 

D) Files contain folders.  

Answer:  C 

Diff: 2 

Objective:  5.  Use File Explorer 

11) Which of the following is FALSE about folders? 

A) Folders can be managed in File Explorer. 

B) Folders contained within other folders are known as file folders. 

C) The sole purpose of a folder is to provide a location for related files. 

D) Folders can be created within other folders. 

Answer:  B 

Diff: 2 

Objective:  5.  Use File Explorer 

 

12) Which of the following is NOT part of the File Explorer interface? 

A) Navigation Pane 

B) Status bar 

C) Content pane 

D) Address bar 

Answer:  B 

Diff: 3 

Objective:  5.  Use File Explorer 

 

13) By default, after you click the SkyDrive tile on the Windows 8 Start screen, which of the 

following items will NOT display? 

A) Documents 

B) Pictures 

C) Public Shared 

D) Libraries 

Answer:  D 

Diff: 3 

Objective:  6.  Work with folder and files 

 

14) In File Explorer, use the ________ key if you want to select a full range of files that are 

adjacent.  

A) Shift 

B) Tab 

C) Ctrl 

D) Alt  

Answer:  A 

Diff: 3 

Objective:  7.  Select, copy, and move multiple files and folders 
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15) To select a variety of files that are not adjacent in order to delete them as a group, hold down 

________ while selecting each one. 

A) F1 

B) Alt 

C) Shift 

D) Ctrl  

Answer:  D 

Diff: 3 

Objective:  7.  Select, copy, and move multiple files and folders 

16) Microsoft ________ is most appropriate to use to create a memo for business use. 

A) Word 

B) Excel 

C) PowerPoint 

D) Access  

Answer:  A 

Diff: 1 

Objective:  8.  Identify common interface components 

 

17) Which of the following is NOT a feature or function available by using Backstage in Office 

2013? 

A) Save a file 

B) View file properties 

C) Move a file 

D) Close a file  

Answer:  C 

Diff: 2 

Objective:  8.  Identify common interface components 

 

18) What information does the title bar of Office 2013 contain? 

A) The file name and the application 

B) The file name and the drive 

C) The file name, folder name, and drive 

D) The application and the drive  

Answer:  A 

Diff: 3 

Objective:  8.  Identify common interface components 

 

19) When do contextual tabs display in Office 2013? 

A) When you select a paragraph in a document 

B) When you right-click the Ribbon and check a conceptual tab name 

C) When you click the Home tab 

D) When you select an object in a document  

Answer:  D 

Diff: 2 

Objective:  8.  Identify common interface components 
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20) Which of the following statements is FALSE about the status bar in Office 2013? 

A) The status bar is located at the bottom of the Office 2013 window. 

B) Contents viewable on the status bar are standard in all Office applications. 

C) Slide number and total slide information are displayed in PowerPoint. 

D) Summary information is displayed in Excel.  

Answer:  B 

Diff: 3 

Objective:  8.  Identify common interface components 

21) Many dialog boxes offer a help feature by clicking: 

A) the F12 key. 

B) a question mark. 

C) the F1 key. 

D) a light bulb.  

Answer:  B 

Diff: 2 

Objective:  9.  Get Office Help 

 

22) Which of the following is TRUE about the Recent Documents list in Office 2013? 

A) It constantly changes. 

B) It is accessed from the Home tab. 

C) All files located on your hard drive can be accessed from it. 

D) It can be quickly accessed with the F10 key. 

Answer:  A 

Diff: 3 

Objective:  10.  Open a file 

 

23) What does clicking the pushpin next to each file name on the Recent Documents list do? 

A) The file will remain on the Recent Documents list for one full week. 

B) The file will remain on the Recent Documents list indefinitely. 

C) The file can be "pinned" to a particular folder that you designate. 

D) The file is available to be "pinned" to the Quick Access Toolbar.  

Answer:  B 

Diff: 3 

Objective:  10.  Open a file 

 

24) Printing a document is available from the ________ tab. 

A) File 

B) Home 

C) View 

D) Page Layout  

Answer:  A 

Diff: 1 

Objective:  11.  Print a file 
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25) When you close a document in Office 2013, what happens to the application? 

A) It automatically remains open for a minimum of 10 additional minutes. 

B) It also closes with the document. 

C) If you close two of more documents simultaneously, the application closes; if only one 

document is closed, the application remains open. 

D) The application remains open.  

Answer:  D 

Diff: 2 

Objective:  12.  Close a file and application 

26) Of the four Microsoft Office 2013 programs, the ________ Home tab is the most unique and 

different than the other programs. 

A) Access 

B) Word 

C) PowerPoint 

D) Excel  

Answer:  A 

Diff: 1 

Objective:  13.  Select and edit text 

 

27) The small dots that surround an object at each corner and in the middle of each side are 

known as: 

A) sliders. 

B) buttons. 

C) handles. 

D) toggles. 

Answer:  C 

Diff: 1 

Objective:  16.  Insert objects 

 

28) In regard to spelling and grammar in Office 2013, it is important to know that, in general: 

A) you turn on the Spelling and Grammar features in all applications. 

B) only a small selection of words will be checked as you type; the rest must be accessed through 

the Spelling and Grammar features. 

C) all Office applications check your spelling and grammar as you type. 

D) Word and PowerPoint check spelling and grammar as you type; Access and Excel do not.  

Answer:  C 

Diff: 3 

Objective:  17.  Review a file 

 



7 

Copyright © 2014 Pearson Education, Inc. 

29) It is most attractive and common that Word documents are printed in ________ orientation. 

Excel documents are most often printed in ________ orientation. 

A) landscape; landscape 

B) landscape; portrait 

C) portrait; landscape 

D) portrait; portrait  

Answer:  C 

Diff: 1 

Objective:  17.  Review a file 

 

30) To set or change margins in a presentation, click the ________ tab. 

A) Home 

B) Design 

C) Insert 

D) Page Layout 

Answer:  D 

Diff: 1 

Objective:  18.  Use the Page Setup dialog box 

31) Windows 8 is an Intel operating system. 

Answer:  FALSE 

Diff: 1 

Objective:  1.  Log in with your Microsoft account 

 

32) You can log in to Windows 8 as a local network user, or you can log in using a Microsoft 

account, but you cannot do both in the same session. 

Answer:  FALSE 

Diff: 2 

Objective:  1.  Log in with your Microsoft account 

 

33) Desktop and SkyDrive are examples of Windows 8 apps. 

Answer:  TRUE 

Diff: 1 

Objective:  2.  Identify the Start screen components 

 

34) Charms include Mail and SkyDrive. 

Answer:  FALSE 

Diff: 1 

Objective:  2.  Identify the Start screen components 

 

35) When dragging a group of tiles on the Windows 8 Start screen, a light gray vertical bar 

displays to indicate where the new group will be located. 

Answer:  TRUE 

Diff: 2 

Objective:  3.  Interact with the Start screen 
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36) The Desktop tile does not display on the Windows 8 Start screen. 

Answer:  FALSE 

Diff: 1 

Objective:  4.  Access the desktop 

 

37) The Notification area of Windows 8 is displayed in the bottom-left corner of the Start screen. 

Answer:  FALSE 

Diff: 1 

Objective:  4.  Access the desktop 

 

38) When you use the Search box in File Explorer, you must type the full search string prior to 

the program searching for your results. 

Answer:  FALSE 

Diff: 2 

Objective:  5.  Use File Explorer 

 

39) Windows 8 does not include libraries like Windows 7 did. 

Answer:  FALSE 

Diff: 2 

Objective:  5.  Use File Explorer 

 

40) Folders can only be created in File Explorer, not within software programs. 

Answer:  FALSE 

Diff: 1 

Objective:  6.  Work with folder and files 

41) SkyDrive can be directly accessed from the Windows 8 Start screen. 

Answer:  TRUE 

Diff: 1 

Objective:  6.  Work with folder and files 

 

42) When you move all files from a folder in one location to a folder in another location, the files 

are duplicated so that they are located in both the original folder location as well as the folder to 

which they were moved. 

Answer:  FALSE 

Diff: 1 

Objective:  7.  Select, copy, and move multiple files and folders 

 

43) Windows 8 offers a feature to show checkboxes next to files and folder names to select in 

order to move, delete, or copy. 

Answer:  TRUE 

Diff: 2 

Objective:  7.  Select, copy, and move multiple files and folders 
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44) In Office 2013, the Help button is located on the Ribbon. 

Answer:  TRUE 

Diff: 1 

Objective:  8.  Identify common interface components 

 

45) By default, the Quick Access Toolbar displays above the Ribbon in Office 2013. 

Answer:  TRUE 

Diff: 2 

Objective:  8.  Identify common interface components 

 

46) The Zoom slider is always displayed at the far left side of the status bar. 

Answer:  FALSE 

Diff: 2 

Objective:  8.  Identify common interface components 

 

47) A professionally-created file such as a budget offered by Microsoft Office and often 

downloaded from the Microsoft Web site is known as a template. 

Answer:  TRUE 

Diff: 2 

Objective:  10.  Open a file 

 

48) Increasing the font size while in Print Preview by using the zoom increases the actual font 

size of the document when printed. 

Answer:  FALSE 

Diff: 1 

Objective:  11.  Print a file 

 

49) Click the File tab, and then click the Exit button to close a Microsoft Office application. 

Answer:  FALSE 

Diff: 2 

Objective:  12.  Close a file and application 

50) You can add your own buttons and features to the Mini toolbar in Office 2013. 

Answer:  FALSE 

Diff: 2 

Objective:  13.  Select and edit text 

 

51) When you use the Find and Replace feature in Office 2013 you can narrow the search to only 

find whole words. 

Answer:  TRUE 

Diff: 2 

Objective:  15.  Use the Editing group commands 
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52) A picture could be a clip art item that you save from the Internet to your hard drive or cloud 

storage. 

Answer:  TRUE 

Diff: 1 

Objective:  16.  Insert objects 

 

53) The mouse pointer changes to a four-headed arrow when you resize an object. 

Answer:  FALSE 

Diff: 1 

Objective:  16.  Insert objects 

 

54) When using the Spelling & Grammar button to check a document, each identified error is 

highlighted in a pane within the window. 

Answer:  TRUE 

Diff: 2 

Objective:  17.  Review a file 

 

55) The Page Setup dialog box offers options to customize margins, select page orientation, and 

center documents vertically. 

Answer:  TRUE 

Diff: 1 

Objective:  18.  Use the Page Setup dialog box 

 

56) ________ is a Microsoft operating system released in 2012. 

Answer:  Windows 8  

Diff: 2 

Objective:  1.  Log in with your Microsoft account 

 

57) The ________ screen is displayed after starting up your computer and entering a username 

and password, if necessary. 

Answer:  Start 

Diff: 2 

Objective:  1.  Log in with your Microsoft account 

 

58) ________ storage is technology used to store files and work with programs that are accessed 

through the Internet. 

Answer:  Cloud 

Diff: 2 

Objective:  1.  Log in with your Microsoft account 

59) ________ is the default location for saving files for Office 2013 applications. 

Answer:  SkyDrive 

Diff: 3 

Objective:  1.  Log in with your Microsoft account 
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60) ________ are made up of five icons that provide functionality to the Start button in Windows 

8. 

Answer:  Charms 

Diff: 2 

Objective:  2.  Identify the Start screen components 

 

61) ________ are colorful block images on the Windows 8 Start screen. 

Answer:  Tiles 

Diff: 2 

Objective:  2.  Identify the Start screen components 

 

62) Removing a tile from the Windows 8 Start screen can be done by right-clicking the tile and 

clicking ________ from Start. 

Answer:  Unpin 

Diff: 2 

Objective:  3.  Interact with the Start screen 

 

63) The ________ is a Windows 8 program that allows you to capture a screen display. 

Answer:  Snipping Tool 

Diff: 2 

Objective:  4.  Access the desktop 

 

64) ________ are folders located within other folders. 

Answer:  Subfolders  

Diff: 1 

Objective:  5.  Use File Explorer 

 

65) The ________ contains five areas: Favorites, Libraries, Homegroup, Computer, and 

Network. 

Answer:  Navigation Pane  

Diff: 3 

Objective:  5.  Use File Explorer 

 

66) The ________ bar informs a user of the current drive or folder. 

Answer:  Address  

Diff: 2 

Objective:  5.  Use File Explorer 

 

67) A(n) ________ is a Windows 8 feature that allows you to share music, pictures, and libraries 

with other people within a home network. 

Answer:  Homegroup  

Diff: 3 

Objective:  5.  Use File Explorer 
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68) Click select all files in an open folder, press and hold ________, and press the A key. 

Answer:  Ctrl  

Diff: 2 

Objective:  7.  Select, copy, and move multiple files and folders 

69) A(n) ________ copy of a file or folder should be copied to another drive in case the original 

drive is damaged or the data is lost for some reason. 

Answer:  backup  

Diff: 1 

Objective:  7.  Select, copy, and move multiple files and folders 

 

70) Press the ________ key to display keyboard shortcuts. 

Answer:  Alt  

Diff: 3 

Objective:  8.  Identify common interface components 

 

71) The ________ is located at the bottom of the window in Office 2013 and contains file 

information. 

Answer:  status bar  

Diff: 3 

Objective:  8.  Identify common interface components 

 

72) The ________ key on the keyboard accesses Help in Office 2013. 

Answer:  F1  

Diff: 2 

Objective:  9.  Get Office Help 

 

73) An enhanced ________ displays in Office 2013 when the mouse pointer is placed over a 

button. 

Answer:  ScreenTip  

Diff: 2 

Objective:  9.  Get Office Help 

 

74) Predesigned files provided within Office are called ________. 

Answer:  templates 

Diff: 2 

Objective:  10.  Open a file 

 

75) The ________ toolbar provides a quick way to format text in Office 2013. 

Answer:  Mini  

Diff: 2 

Objective:  13.  Select and edit text 

 

76) A key or feature that can be turned on or off is known as a(n) ________ command. 

Answer:  toggle  

Diff: 2 

Objective:  13.  Select and edit text 
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77) An area of memory reserved to temporarily hold selections that have been cut or copied from 

a document is known as the ________. 

Answer:  Clipboard  

Diff: 1 

Objective:  14.  Use the Clipboard group commands 

78) The ________ allows you to quickly and easily copy formatting from one area of a document 

to another. 

Answer:  Format Painter  

Diff: 2 

Objective:  14.  Use the Clipboard group commands 

 

79) The Replace button is located on the ________ tab in Office 2013. 

Answer:  Home  

Diff: 2 

Objective:  15.  Use the Editing group commands 

 

80) ________ options are the settings that are in effect when an application is installed. Spelling 

and grammar checker as active is one example of this. 

Answer:   Default 

Diff: 2 

Objective:  17.  Review a file 

 

81) Match the following terms with their description: 

I. Start screen 

II. operating system 

III. Windows 8 

IV. SkyDrive 

V. cloud storage 

 

A. displays after starting your Windows 8 computer 

B. released in 2012 

C. used to store files and to work with programs located on the Internet 

D. an app used to store, access, and share files and folder 

E. software that directs computer activities 

Answer:  A, E, B, D, C  

Diff: 1 

Objective:  Multiple objectives 
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82) Match the following terms with their description: 

I. Charms 

II. Start button 

III. Start screen 

IV. Windows 8 app 

V. tiles 

 

A. designed to run in the Start screen of Windows 8 

B. colorful block images on the Windows 8 Start screen 

C. functionality similar to the Start button in previous Windows versions 

D. not a part of Windows 8 

E. made up of several tiles 

Answer:  C, D, E, A, B 

Diff: 2 

Objective:  Multiple objectives 

83) Match the following parts of the File Explorer interface with their function: 

I. Address bar 

II. Content pane 

III. Details pane 

IV. Navigation pane 

V. Toolbar 

 

A. shows currently selected folder or library 

B. shows properties associated with a selected file 

C. includes buttons relevant to currently selected item 

D. contains Favorites, Libraries, Homegroup, Computer, and Network 

E. navigate to other folders or libraries 

Answer:  E, A, B, D, C 

Diff: 3 

Objective:  5.  Use File Explorer 

 

84) Match the following keyboard shortcuts in many programs with their function: 

I. Ctrl+C 

II. Ctrl+V 

III. Ctrl+Z 

IV. Ctrl+X 

V. Ctrl+A 

 

A. Copy 

B. Paste 

C. Select all 

D. Undo 

E. Cut 

Answer:  A, B, D, E, C 

Diff: 1 

Objective:  Multiple objectives 
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85) Match the following components of Office 2013 and their function: 

I. Backstage view 

II. Quick Access Toolbar 

III. title bar 

IV. Ribbon 

V. Dialog Box Launcher 

 

A. easy access to commonly executed tasks 

B. displays the current file name and application 

C. used to print, save, open, close, and share a file 

D. contains tabs, groups, and commands 

E. opens a corresponding box that provides access to precise tools 

Answer:  C, A, B, D, E 

Diff: 1 

Objective:  8.  Identify common interface components 

86) Match the following Microsoft Office 2013 features with the tab where they can be found: 

I. access Backstage view 

II. tab that automatically displays when a file is opened 

III. create a footer in Word 

IV. change the zoom level 

V. change margins in Word 

 

A. File tab 

B. View tab 

C. Page Layout tab 

D. Insert tab 

E. Home tab 

Answer:  A, E, D, B, C 

Diff: 2 

Objective:  Multiple objectives 
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87) Match the following shortcut actions to the selection in Word or PowerPoint: 

I. double-click 

II. triple-click 

III. press and hold Ctrl while you click to select 

IV. press and hold Shift while you press the right arrow key 

V. press and hold Ctrl while you press the letter A 

 

A. a sentence  

B. a paragraph 

C. one character to the right 

D. entire document 

E. a word 

Answer:  E, B, A, C, D 

Diff: 2 

Objective:  8.  Identify common interface components 

 

88) Match the grammar or spelling error with the Office 2013 identification or button to click: 

I. you write "there" instead of "their" 

II. you write "recieve" instead of "receive" 

III. you leave out a necessary comma 

IV. you want it to not stop on your name in the future  

V. you want to bypass all occurrences of "daycare" 

 

A. Ignore All 

B. red wavy underline 

C. green underline 

D. blue underline 

E. Add to Dictionary 

Answer:  D, B, C, E, A 

Diff: 2 

Objective:  15.  Use the Editing group commands 

89) Match the following features or parts of Office 2013 to their description: 

I. contextual tab 

II. Mini toolbar 

III. title bar 

IV. gallery 

V. status bar 

 

A. easy access to formatting commands 

B. contains groups of commands related to a specific, selected object 

C. set of selections when you click a More button 

D. contains information relative to the open file 

E. includes file name and application 

Answer:  B, A, E, C, D  

Diff: 2 

Objective:  Multiple objectives 
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90) Match the following Microsoft Office 2013 feature with the tab where it can be found: 

I. open Office Backstage 

II. modify text 

III. create a new chart in Excel 

IV. modify an object  

V. change margins in Word 

 

A. contextual tab  

B. File tab 

C. Home tab 

D. Page Layout tab 

E. Insert tab 

Answer:  B, C, E, A, D  

Diff: 2 

Objective:  Multiple objectives 

 

91) What is the default location for saving files in Office 2013 applications? Briefly describe it. 

Answer:  SkyDrive is the default location for saving files in Office 2013. SkyDrive is an app 

used to store, access, and share files and folders. 

Diff: 3 

Objective:  1.  Log in with your Microsoft account 

 

92) Describe tiles. 

Answer:  Tiles are colorful block images available on the Windows 8 Start screen. When you 

click a tile, you will be taken to a program, file, folder, or other Windows 8 app. Tiles include the 

name of the app or program. 

Diff: 2 

Objective:  2.  Identify the Start screen components 

 

93) When might you want to use the Snipping Tool? 

Answer:  The Snipping Tool, a Windows 8 accessory program, can be used to take a screen 

image that can be saved, annotated, or shared into and with other programs. The Snipping Tools 

offers Free-form, Rectangle, Window, and Full-screen snips. 

Diff: 2 

Objective:  4.  Access the desktop 

94) Describe the function of Homegroup in Windows 8. 

Answer:  Homegroup is a Windows 8 feature that enables you to share resources on a home 

network. Music, pictures, videos, and libraries can easily be shared in a home network through a 

Homegroup. It is password protected. 

Diff: 3 

Objective:  5.  Use File Explorer 
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95) What is a theme in Microsoft Office 2013? 

Answer:  A theme is a collection of design choices that includes colors, fonts, and special effects 

used to give a consistent look to a document, workbook, or presentation. 

Diff: 2 

Objective:  8.  Identify common interface components 

 

96) Name at least four tasks that are available in Microsoft Office 2013 Backstage view. 

Answer:  You can open saved files, create new files, print items, and save and close files. In 

Backstage view, you can also indicate options, preferences, and settings in the program you are 

using. You can also exit an application as well as identify file information, such as the author or 

date created. 

Diff: 3 

Objective:  10.  Open a file 

 

97) When and how does the Mini toolbar appear in Office 2013? What is it used for? 

Answer:  When any amount of text is selected within a worksheet, document, or presentation, 

you can slightly move the mouse pointer within the selection to display the Mini toolbar. The 

Mini toolbar provides access to most common formatting selections. 

Diff: 3 

Objective:  13.  Select and edit text 

 

98) What can you do from the Clipboard group on the Home tab? 

Answer:  You can copy and cut text as well as objects from the Clipboard group. You can also 

paste as well as copy and paste formats from one location in a document to another. 

Diff: 2 

Objective:  14.  Use the Clipboard group commands 

 

99) What happens when you press Ctrl+F in a Word file? 

Answer:  Ctrl+F is a shortcut used to find items. Ctrl+F opens the Navigation Pane on the left 

side of the Word document. When you type a search term in the Search Document area, Word 

finds and highlights all occurrences of that search term. 

Diff: 2 

Objective:  15.  Use the Editing group commands 

 

100) Describe SmartArt in Office 2013. 

Answer:  SmartArt is a diagram that presents information visually to effectively communicate a 

message. SmartArt is considered an object and can be managed independently of an underlying 

document, worksheet, or presentation. 

Diff: 2 

Objective:  16.  Insert objects 
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